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 مقدمة

الحمد لله الذي علَّم بالقلم، علَّم الإنسان ما لم يعلم، والصلاة والسلام على من بُعث مُعلماً 

 فأخرج الناس من ظلمات الجهل والغواية، ؛وسراجاً منيراًالله بإذنه إلى  للناس وهادياً وبشيراً، وداعياً

مد بن عبدالله وعلى آله وصحبه أجمعين، نور العلم والهداية، نبينا ومعلمنا وقدوتنا الأول محإلى 

 أما بعد:

تسعى المؤسسة العامة للتدريب التقني والمهني لتأهيل الكوادر الوطنية المدربة القادرة على 

التقنية والفنية والمهنية المتوفرة في سوق العمل السعودي، ويأتي هذا الاهتمام نتيجة شغل الوظائف 

للتوجهات السديدة من لدن قادة هذا الوطن التي تصب في مجملها نحو إيجاد وطن متكامل يعتمد 

في  ذاتياً على الله ثم على موارده وعلى قوة شبابه المسلح بالعلم والإيمان من أجل الاستمرار قدماً

 دفع عجلة التقدم التنموي، لتصل بعون الله تعالى لمصاف الدول المتقدمة صناعياً.

وقد خطت الإدارة العامة للمناهج خطوة إيجابية تتفق مع التجارب الدولية المتقدمة في بناء 

البرامج التدريبية، وفق أساليب علمية حديثة تحاكي متطلبات سوق العمل بكافة تخصصاته لتلبي 

لمتطلبات، وقد تمثلت هذه الخطوة في مشروع إعداد المعايير المهنية الوطنية ومن بعده مشروع تلك ا

المؤهلات المهنية الوطنية، والذي يمثل كل منهما في زمنه، الركيزة الأساسية في بناء البرامج 

تمثل  التدريبية، إذ تعتمد المعايير وكذلك المؤهلات لاحقاً في بنائها على تشكيل لجان تخصصية

سوق العمل والمؤسسة العامة للتدريب التقني والمهني بحيث تتوافق الرؤية العلمية مع الواقع العملي 

الذي تفرضه متطلبات سوق العمل، لتخرج هذه اللجان في النهاية بنظرة متكاملة لبرنامج تدريبي 

 واقعية في تحقيق متطلباته الأساسية. أكثرالتصاقاً بسوق العمل، و أكثر

 "الرسم المعماري" تخصصلمتدربي  "مبادئ الرسم بالحاسب"التدريبية  الحقيبةوتتناول هذه 

موضوعات حيوية تتناول كيفية اكتساب ، ومعاهد العمارة والتشييد في المعاهد الصناعية الثانوية

لتكون مهاراتها رافداً لهم في حياتهم العملية بعد تخرجهم من هذا  البرنامجاللازمة لهذا  المهارات

والإدارة العامة للمناهج وهي تضع بين يديك هذه الحقيبة التدريبية تأمل من الله عز وجل  البرنامج.

 أن تسهم بشكل مباشر في تأصيل المهارات الضرورية اللازمة، بأسلوب مبسط خالٍ من التعقيد. 

وفق القائمين على إعدادها والمستفيدين منها لما يحبه ويرضاه؛ إنه سميع والله نسأل أن ي

 مجيب الدعاء.

 الإدارة العامة للمناهج
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 رقم الصفحة الموضـــــوع

 Ortho  44 استخدام وضع التعامد

 45 ياتحداثالرسم باستخدام الإ

 Absolute Coordinates 45  ي المطلقحداثالإ

 Relative Coordinates 45  ي النسبيحداثالإ

 Polar Coordinates 46  ي القطبيحداثالإ

 46 ياتحداثأنواع الإ

 Polar Coordinates 46  يات القطبية الافتراضيةحداثالإ

 48 ياتحداثالرسم بالإ

 51 الرسم باستخدام الشبكة المساعدة

 Grid 51  الشبكة المساعدة

 Grid 51 أمر  تفعيل

 Snap 53  أمر المغنطة / القفز

 Snap 53الأمر  تفعيل

 Object 57 تحديد العنصر

 Move 59  التحريك

 Block 63  كيف تعمل كتلة

 Copy 65  النسخ

 Block Editing 66  تعديل الكتلة

 Explode 69  تفجير وتسمى Block إلغاء الـ

 Toilet Seat 69    مرحاض مسقط رسم: مثال

 Trim 71  أمر القطع

 74 للرسمالتخطيط 
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 رقم الصفحة الموضـــــوع

 Offset 75  أمر النسخ بالتوازي

 Mirror 81  التناظر

 Erasing 83  حذف الخطوط المساعدة

 Fillet 84  جمع الزاوية

 86 جراء التعديل بالمقاساتإتعدد الخيارات و

 Stretch 87  أمر الشد

 Block 95  عمل كتلة

 Extend 99 أو  أمر الاستمرار

 Blocks 103إدراج الـ

 Rotate 106  الدوران أمر

 Scale 107  أمر تغيير الحجم

 112 تمارين الوحدة

 117 : استخدام الطبقات والكتلةالوحدة الثالث

 Layer 119  الوصول للأمر

 Layer Properties Manger 122  شرح واجهة

 124 ضافة نوع خطإ

 Properties 129  قائمة

 Wblock 131  مرأ

 131 كيف تنشئ نافذة؟

 135 تمارين الوحدة

 139 والنصوص وتظليل الرسومات بعادالوحدة الرابعة: إضافة الأ

 Text 140  النصوص
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 رقم الصفحة الموضـــــوع

 140 لى الرسمإضافة النصوص إ أوامر

 Style Text 144  إنشاء أنماط مختلفة للنصوص

 146 تنسيق النص

 149 كتابة البيانات والمعلومات على المخططات

 150 الرموز

 Table 150  إضافة جدول

 159 رموز التهاشير واستخداماتها

 Dimension 160  بعادالأ

 160 بعادمكونات خطوط الأ

 160 بعادعمل أنماط مختلفة للأ

 166 بعادأدوات عمل الأ

 169 تمارين الوحدة

 174 تمارين: مشروع فيلا سكنية

 174 الملحوظات المعمارية

 176 جدول الأبواب

 177 جدول الشبابيك

 188 المراجــع

 189 الملحقات

 190 الملحقات )أ( الجلوس والتمارين الصحيحة للأعمال المكتبية

 191 وتوكادطريقة تثبيت برنامج الأ الملحقات )ب(
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 تمهيد

 الحقيبة:الهدف العام من 

 مبادئ في استخدامالتأسيسية المعارف والمهارات إكساب المتدرب إلى  تهدف هذه الحقيبة

  الرسم بالحاسب.

 بالحقيبة:تعريف 

 .مبادئ الرسم بالحاسبتقدم هذه الحقيبة  

 التدريبية:الوقت المتوقع لإتمام التدريب على مهارات هذه الحقيبة 

 كالتالي:موزعة  تدريبية،ساعة  80ذه الحقيبة في يتم التدريب على مهارات ه

 تدريبية ساعة AutoCAD 20وتوكاد الأواجهة برنامج  استكشاف الأولى: الوحدة

 ساعة تدريبية 20 الرسم والتعديل أوامر الوحدة الثانية:

 ساعة تدريبية 20 تنظيم العمل باستخدام الطبقات والكتل الوحدة الثالثة:

 ساعة تدريبية 20 والنصوص وتظليل الرسومات بعادإضافة الأ :الرابعةالوحدة 

 للحقيبة:الأهداف التفصيلية 

 :وبكفاءة على أنيكون المتدرب قادراً  التدريبية أنمن المتوقع في نهاية هذه الحقيبة 

 .الأوتوكادواجهة برنامج  يشرح .1

 .في سوق العمل المعتمدةبرامج الرسم  يستخدم .2

 .المختلفةالرسم  أوامر يطبق .3

 .والكتل الطبقات باستخدام العمل ينظم .4

 .المختلفةاللوحات المعمارية  يرسم .5

 .بعد الانتهاء من العمل الرسم يحفظ .6

 

 

 

 



 مبادئ الرسم بالحاسب

 

 رسمع 011

 

 
8 

  

 الوحدة الأولى

 AutoCADاستكشاف واجهة برنامج أوتوكاد 
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 الوحدة الأولى

 AutoCADواجهة برنامج أوتوكاد  استكشاف

 العام للوحدة: الهدف

استكشاف  المعارف والمهارات التأسيسية فيإكساب المتدرب إلى  تهدف هذه الحقيبة

 AutoCADواجهة برنامج أوتوكاد 

  التفصيلية: الأهداف

 :أن علىوبكفاءة  من المتوقع في نهاية هذه الوحدة التدريبية أن يكون المتدرب قادراً

 .بالبرنامجالشاشة الخاصة  يحدد محتويات .1

 .لرسوماتلفظ الحغلاق والإفتح ويطبق أوامر ال .2

 .عدل على الرسوماتي .3

 .المساعدة وامرالأ يطبق .4

 ساعات تدريبية. 20 الوحدة:على هذه  بالمتوقع للتدري الوقت

 الوسائل المساعدة: 

 .A5دفتر مربعات بحجم  .1

 .قلم .2

 .الحقيبة التدريبية .3

 .مع ملحقاتهلي آجهاز حاسب  .4

 .جهاز عرض بياناتو أشبكة تعليمية  .5
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 لغة الرسم

من النقاط والخطوط البسيطة  ذاتالوبيطور لغة التخاطب والكتابة نسان خذ الإأعبر العصور 

مهام  لإنجازفي حال تطوير مستمر  طبيعة البشر تجرالرسومات الهندسية المعقدة. فهكذا لى إ

 .دقأسرع وأو أكبر

 
 .مصر في الهولوغروفية اللغة( 1 -1شكل )

 
 وأُرخ عليها وقع نهأب ونلاحظ طباعتها إعادة تتم الفونوجراف لجهاز ديسونأ توماس للمخترع بياني رسم( 2 -1شكل )

 م12/8/1977 في التاريخ

باستخدام الرسوم التوضيحية وتطور ليستخدم  ابتدأللرسم الهندسي الأمر  فهكذا كان

 . ليالآالحاسب لى إوصل ن ألى إالهندسية المعقدة دوات الأبه 

 . فدائما ماخط عبثي أيوجد  شيء معين ولالى إبهذه الرسومات كل خط بها يرمز ن أو

جزء هو يمثل من ي أولذي يعنيه هذا الخط ا نعرف ماننا أبنعرفه ونستذكره باستمرار ن أيجب 

 .المبنى

ينصح به قبل البدء بالعمل على برامج الرسم بالحاسب هو وجود رسم توضيحي  ودائما ما

 الرسومات الهندسية.نجاز إيدوي يساعد في سرعة 
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 ؟CADنظام الكاد  وما ه

. وهو نظام يحول Computer Aid Designهي اختصار لثلاث كلمات  CADكلمة 

كية. ونظرا لاعتماد الرسومات الهندسية وارتباطها بحسابات يبيانات جرافلى إالبيانات الرقمية 

 اهذه الحسابات ودمجها مع الرسومات لتوفر لنا وقتإدخال دقيقة طور هذا النظام ليتمكن من 

مقاطع لى إتصل ن ألى إ 2D بعادالأبرسومات ثنائية  أتبد. نسانالإودقة عالية تفوق قدرة  اوجهد

 فيديو تجسد التطبيق الفني التقني لمهمة توصيل فكرة وصورة واضحة عن المشروع.

 

 .التقليدية الرسم دواتأ باستخدام ( رسم3 -1شكل )

 

 بالحاسب الرسم من ولىالأ النسخة (4 -1شكل )

 .SketchPad  يسمى CAD system بنظام

 AutoCADالبرامج الحديثة التي تنافس برنامج 

الكبيرة التي  معايير الجودة والتميزعلى أنتاج إالسوق العالمي مليء بالمنافسات الضخمة في 

ولكن كل دولة  منتجاتهم الهندسية بكفاءة عالية.تساعد المهندسين والفنيين على تقديم 

سباب الأيبحثون عن الجودة وتختلف  ةوتار ،براز منتجها المحلي والتسويق لهومنطقة تسعى لإ

 Autodeskمن شركة وتوكاد الأيستخدم نظام بحسب الظروف المحيطة. ولكن في المملكة 

من المكاتب الهندسية لاستخدام هذا  اًكثير مما يجبر ،المعتمد عند الجهات الحكوميةوهو 

وسع أ له على غيره. كذلك توفير الشركة فرصة لتعلم البرنامج يتيح مجالايالنظام وتفض

 .للانتشار
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  المستخدمة في مجال التصميم البرامجبعرض عدد من  نبدأ

ARCHICAD 

 

عداد أيتيح لك حيث وتوكاد وهو البرنامج الأكثر منافسة لبرنامج الأ

 BIMبسرعة كبيرة. ويدعم نظام  بعادثنائية وثلاثية الأرسومات 

(Building Information Modeling)  ويسمح لك هذا البرنامج

نها أبمشاركة الملفات والعمل على ملف من قبل شخصين وأكثر و

 سنة. 30لشركة عريقة عمرها أكثر من 

 : ArchiCAD لـبرنامجالموقع الرسمي 

 https://www.graphisoft.com/archicad 

 

 
 .ARCHICAD برنامج واجهة (5 -1شكل )

 

MicroStation 

 

 متخصص لإنشاء وهو برنامج Bentleyنتاج شركة إهذا البرنامج من 

. يستخدم BIMويدعم تقنية  بعادوثلاثي الألشكل ثنائي  البنية التحتية.

 .رامكو السعودية من قبل بعض المقاولينأفي المملكة من قبل شركة 

 

 

https://www.graphisoft.com/archicad
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 :MicroStation  لبرنامجالرسمي  الموقع
 

-and-line/modeling-https://www.bentley.com/en/products/product

software/microstation-visualization 

 

 
 .MicroStation برنامج واجهة( 6 -1شكل )

 

SOLIDWORKS 

 

هذا البرنامج متخصص لإنتاج رسومات هندسية لدراسة الحركات 

يستخدم بكثرة من قبل  ،والمواد المستخدمةالديناميكية للتصاميم 

 .ئيينالمهندسين الميكانيكيين والكهربا

 

 

 :SolidWorks  الموقع الرسمي لبرنامج

 

 https://www.3ds.com/products-services/solidworks/?wockw=Solidworks 

 

https://www.bentley.com/en/products/product-line/modeling-and-visualization-software/microstation
https://www.bentley.com/en/products/product-line/modeling-and-visualization-software/microstation
https://www.3ds.com/products-services/solidworks/?wockw=Solidworks
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 .SOLIDWORKS برنامج واجهة( 7 -1شكل )

هذا كان استعراض لمجموعة من البرامج المستخدمة على النطاق العالمي في مختلف 

مما يختصر عليك الكثير من الطريق  ،التخصصات الهندسية. جميعها يحمل نفس مبادئ الرسم

بن اونختم بقول الخليفة علي  ،عالم جديد من البرامج لأيلدخول باتتردد  لتعلم البرنامج. فلا

 ينتهي(. )العلم لا-رضي الله عنه -طالب بي أ
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 قبل فتح البرنامج

. AutoCADوتوكاد أعلينا بالتعرف على النظام الذي يعمل به برنامج الرسم المعماري 

منتهية وتعرف رياضيا  يوفر لك صفحة لانه إحيث  ،ياتحداثيعتمد البرنامج على الرسم بنظام الإ

والتي تحتوي  ،نتهيةالمغير ة يالحقيق رقامهذا النظام يستخدم الأن إحيث  ،بالهندسة الفراغية

 بقيمة موجبة وسالبة. أرقامعلى كسور و

( والتي ترجع 0,0يات التي يكون مركزها ) حداثعلى سطح شبكة الإ رقامتطبق هذه الأ

 .تساوي ) صفر، صفر( (x,y)قيمة كل من ن أب

 
 .y والمحور x المحور وهما محورين من يتكون والذي 2D بعادالأ ثنائي ياتحداثالإ شبكة سطح( 8 -1شكل )

 

 :تيةالآباستخدام هذه الشبكة يمكنك تحديد مكان كل نقطة من النقاط  تمرين:

(0, 0); (0,4); (4, -2); (-2, -4); (1, 3). 
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 .وتوكادالأ برنامج على الشبكة توزيع طريقة البياني الشكل هذا يوضح( 9 -1شكل )

البيانات إدخال وهذا الجزء يسهل علينا العمل ن لأنرسم على الجزء الموجب  دائما ما

 يات من جهاز الرفع المساحي.حداثالبيانات والإخذ أتم إذا بالخصوص  ،ياتحداثوالإ

 فتح البرنامج

باستخدام فتح البرنامج ا البرنامج( لتنزيلالملحقات )ب(  )راجعبعد تثبيت البرنامج 

 :الخطوات التالية

 

 – AutoCAD 2021 على سطح المكتبوتوكاد يقونة الأأيمكنك النقر مرتين على   .1

English  من شريط بالفتح( أو)، مكن من فتح البرنامجلتت: 

 Autodesk > AutoCAD 2021 – English <قائمة البرامج   <أبدا

Start> All programs> Autodesk> AutoCAD 2021-English 

عديد من الخيارات منها فتح ملف إلى  ستفتح لك واجهة البرنامج التي تتيح لك الوصول  .2

 ،Autodesk 360السحابية عمال الأى قائمة الدخول عل ،فتح ملف سابق العمل جديد،

نجليزية الإوالتي توصلك لدروس باللغة   Learnالتعلميقونة أالشاشة هناك  بأسفل ذلكك

 .البرنامجساسيات أعن نترنت الأعلى شبكة 
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 .AutoCADالـ برنامج واجهة( 10 -1شكل )

والتي تتيح لك ملف عمل  Get Startنامج برمن واجهة اليسر الأسنلاحظ على الجزء  .3

 . Drawing1.dwgوتوكاد أ

 .(11 -1شكل )كما في  Start Drawing  وهوزر الملف عمل جديد فلنضغط حاليا على  .4

 .(12 -1شكل )ستظهر لك واجهة البرنامج كما بال .5

 

 .جديد عمل ملف لتفتح الشكل هذا على اضغط( 11 -1شكل )
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 .وامرالأ بواجهة تعريف( 12 -1شكل )

البرنامج يقونة أمن خلال و أحفظ العمل بسرعة  بالإمكانالسريع دوات الأبشريط  .6

شكل انظر البشكل مستمر  SAVEمرة ومن ثم  لأولللحفظ   SAVE ASاضغط 

(1- 13). 

 

من عدم ضياع  تأكدلللك وذ ،احرص على حفظ عملك بشكل مستمر ملاحظة

من الحفظ  تأكدلذا  ،بشكل مفاجئ بالبرنامجعطل ي أالوقت لو حصل 

 .(دقائق 10بشكل ) كل 
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 .العمل حفظ مكان يوضح السريع الوصول قائمة( 13 -1شكل )

حفظ باسم سيتوجب علينا كتابة اسم المشروع ورمزه ومن   Save Asبعد الضغط على 

 .وهذه الصيغة التي يتعرف عليها البرنامج dwgثم تحدد صيغة البرنامج 

 

 صيغة نأب ونتأكد كمثال Project 1 الملف اسم وتسجيل فيه الحفظ المراد الملف مكان تحديد( 14 -1شكل )

 .dwg تكون الملف
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بصيغة الحفظ ا محدهأهناك ملفين في نفس الموقع ن أببعد حفظ الملف ستجد  ملاحظة

dwg خر والآbak يذتتعامل بشكل دائم مع ملف المشروع  أنكب تأكد 

هو ملف  bak. ملف الـ خرالآوهو الذي تفتح المشروع منه وليس  dwgالصيغة 

Backup   لإصلاح مما يستخدوهو  ،ليالآلغرض استعادة البيانات والحفظ 

 بأعلىبالذهاب لزر قائمة البرامج  ذلكو dwgملف المشروع في حال تعطل ملف 

 ومن ثم الشاشة لليسار

Drawing Utility > Recovery>Recovery 

 
 .dwg , bak الملفين كلا الصورة توضح( 15 -1شكل )

 

 

بعد التعرف على كيفية الحفظ دعنا نتعرف على كيفية فتح ملف جديد وهي من خلال 

 .زر قائمة البرنامج
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 .الملفات وفتح حفظ من تمكنك والتي البرنامج قائمة( 16 -1شكل )

  .حفظهبهذا القدر قد تعلمنا كيفية فتح البرنامج وطريقة فتح مشروع جديد وطريقة 
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 قوائم البرنامج

 ،عمالالأ ازنجلإدوات والتي تستخدم والأ وامرالأشاشة البرنامج مجموعة من  بأعلىنلاحظ 

فتتصدر هذه القائمة  ،دواتالأموعات من لمجتكون من قوائم والتي ت ،الأوامرمن قائمة  نبدأو

HOME الرسم والتعديل  أوامرتحتها  ندرجتفي البرنامج والتي  اًاستخدام كثروهي القائمة الأ

 .المساعدة وامرالأوغيرها من 

فمثلا هنالك قائمة  ،التي تقسم حسب العملدوات الأهنالك قوائم  HOMEتحت قائمة 

Draw  عند ترك مؤشر الفأرة  ،الهندسية المختلفةشكال الأومن هنا نستطيع رسم  "رسم"وتعني

مع فيديو متحرك داة الأالقائمة تتسع وتشرح ن ألمدة عدد من الثواني نلاحظ  واتالأدحد أعلى 

والتي سنشرحها لاحقا  Commandقائمة  فيالأمر  يشرح طريقة الاستخدام وطريقة كتابة

 .(17 -1شكل )انظر ال

 
 .والتعديل للرسم تستخدم التي المختلفة دواتوالأ وامرالأ قوائم بالصورة لنا يتضح( 17 -1شكل )

وهذه  ،وامرالأمرتين يمكن تغيير طريقة عرض يسر الأبالزر  وامرالأبالضغط على قوائم 

 القائمة ستظهر بشكل تلقائي في حال لو كنت تعمل على شاشة عمل صغيرة.

 
 .وامرالأ قوائم لعرض مختلفة طريقة (18 -1شكل )
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 للشكل الثالث ومن ثم يرجع للشكل المعتاد  وامرالأبتكرار العملية يمكن تغيير شريط قوائم 

 
 .وامرالأ شريط عرض لطريقة الثالث الشكل (19 -1شكل )

 .ولالأمرتين لنرجع للشكل الاعتيادي   HOMEفنضغط على كلمة ن ما الآأ

 
 

 

 

ذات السهم التي توحي بتكبير القائمة سنلاحظ  Draw( بالضغط على كلمة 20 -1شكل )

 .الأدواتزيادة عدد 

 

فنرى السهم المجاور لـ  ت،أدوامخفية مضافة لكل قائمة  أوامرهناك ن أوهكذا نتعلم 

Draw  الإضافيةونسميها قائمة الرسم (Expansion drawing panel) .هناك ن أبنلاحظ يضا أو

لرسم ضافية إوهذا يتيح لنا خيارات  Arcو Circleصغيرة تحت الشكل الدائرة  اًأسهم

 بنفسك.  ذلكيمكنك تجربة و ،الدائرة
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 .Circle الدائرةداة لأ ضافيةالإ القائمة( 20 -1شكل )

 

هذا يوفر عليك بعض الوقت ويزيد من و ،اختصاردوات الأمن أداة لكل  ملاحظة

وليين الأالحرفين و أأمر  من كلول الأففي الغالب الحرف  ،كفاءة العمل

باختياره بالضغط على مفتاح مسافة مباشرة يسمح لك الأمر  كتابةو أ

 هما نكتبوهذا  CIRCLEالسطر كلمة خر آببالشكل نلاحظ  كمثال

تدريجيا سنتعلم بعضها ولكن تذكر عزيزي ،  COMMANDفي قائمة 

السرعة عامل ضروري إن لعمل بل ل ييكف لاتعلم البرنامج ن أبالمتدرب 

 .للإنجاز
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 .المفاتيح لوحة على تكتبه ما حسب البرنامج من قترحاتم ظهور( 21 -1شكل )

 Command وامرالأنافذة 

والتي  ،السفلي من نافذة البرنامجوسط الأالجزء بالقوائم الضرورية التي تقع هم أوهذه من 

تظهر لك خيارات يضا أو ،باستخدام اختصارات لوحة النوافذالأوامر من خلالها تستطيع كتابة 

 Control + 9النافذة يمكنك الضغط على زر غلاق إفي حال  –تختارها أداة لكل ضافية إ

الذي  مرلألهو ضغط الحرف  كما عليفكل زرق الأحيث تكون باللون  –خرى أمرة  لإظهارها

 نضغط على مفتاح مسافة لتفعيل الاختيار.تريد ثم 

 
الأمر  بكتابة منها يأ اختيار إمكانكب CIRCLE الدائرة لأمر ضافيةإ خيارات 3 هناك نأب نرى( 22 -1شكل )

 .3Pأو  2P سواء

 ةالمساعد وامرالأشريط 

بعض المهام بطريقة نجاز إالمساعدة هي مجموعة من الخيارات التي تساعد على  وامرالأ

نجد و ،وامرالأإدخال طريقة و أكانت لها علاقة بطريقة عرض البيانات أسلسة وسريعة سواء 

التي يمكن زيادتها يقونات الأوالذي يحتوي على عدد من  ،يسار الصفحة بأسفلهذا الشريط 

التي  الرئيسةهو وجود العناصر ول الأعليه في المستوى  زما سنركوتقليصها حسب الحاجة لها. 

  .وتوكادالأتساعدنا على الرسم على برنامج 

 
 بعضها نأب ونلاحظ زرقالأ باللون تظهر والتي المفعلة وامرالأ من اًعدد المساعدة وامرالأ شريط في نجد( 23 -1شكل )

 .تكبيره يمكن

  2Dبعادقائمتين ضروريتين لبدء رسم ثنائي الأفي هذا المستوى من التدريب سنركز على 

(2 DIMENSIONAL). 
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1. SNIP TOOL : ووسط ونهاية  ةالخيار بتحديد خيار بداي المغنطة التي تتيح لكأداة وهي

على لوحة  F3يمكن تفعيلها بالضغط على الاختصار رمزية مختلفة  الخط بإشارات

 .المفاتيح

 
 ثناءأ الخيارات كل تفعيل يفضلو ،المختلفة الخيارات لتعطينا القائمة ستتسع السهم على الضغط عند( 24 -1شكل )

 .OBJECT SNAP SETTINGS على الضغط طريق عن خصائص على بالدخول وأ يدويا ذلكو بعادالأ ثنائي الرسم

 

 .المساعدة وامرالأ جميع اختيار لك يتيح SELECT ALL خيار على بالضغط( 25 -1شكل )
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2. ESTRICTED CURSOR  يتيح لك الرسم بخطوط عامودية  ةالاستقامالأمر  هذا

 .على لوحة المفاتيح F8واختصار التفعيل له هو زر  0و أدرجة  90بزاوية ي أفقية أو

 دالمساعالأمر  والذي يفعل F9الشائعة هو الضغط على مفتاح خطاء الأمن  ملاحظة

Snapmode توجدإذا لذا  ،وهو يلزمك بالتحرك بنظام شبكة متقاطعة 

بالضغط على  تأكدتستجيب بالشكل الصحيح  تتحرك بغرابة ولارة أالف

 . F9مفتاح 

 

 
  .فقيلأا وأ عاموديبكلا الاتجاهين ال مستقيمة خطوط رسم من تمكننا والتي الاستقامةأداة ( 26 -1شكل )

 

 منتصف خط

 

 نهاية خط

 
 تقاطع

 

 تعامد

 .SNIPING TOOL على مثلةأ( 27 -1شكل )

 رة ولوحة المفاتيح أالتعامل مع الف

رة لتمكنك من أعلى الفخرى والأالطريقة الصحيحة للعمل هي بوضع يد على لوحة المفاتيح 

 مما يزيد من سرعة وكفاءة العمل. ،استخدام الاختصارات

 



 مبادئ الرسم بالحاسب

 

 رسمع 011

 

 
28 

 MOUSEرة أالف

والتي ستسهل عليك الوصول لعدد من الرسم الهندسي ثناء أرة أالفطرق بالتعامل مع  كهنا

هناك ن أب( 28 -1شكل )بال حهو موضالاختصارات التي ستوفر عليك الجهد والوقت. كما 

ن أيضا بأونلاحظ  ،المختلفةالأوامر لاختيار يسر الأالعادة هو الزر ب هما نستخدمزرار أثلاثة 

 فهي: مالمستخدالأمر  تتغير طبقا لنوعرة أالفشارة 

 أمر  يألم تختر  إلى أنكوهذا الشكل الاعتيادي والذي يشير  ،موجب ومربع بالمنتصف

 .-اًرسم أم تعديلًاأكان سواء -

 البياناتإدخال والرسم إلى  موجب وهذا الشكل يشير. 

 التعديلدوات أإلى  المربع يشير.   

 
 .وسطوالأ يسروالأ يمينالأ زرارأ ثلاثة به يوجد نهإ حيث مناسب رةأالف من النوع هذا( 28 -1شكل )

 التكبير والتحريك

طريقة سرع أولكن  ،دواتوالأ الأوامريمكن الوصول لهما عن طريق ن امرالأ نوهذا

عبارة عن ن يمرن الأين هذإلى أونود التنويه  ،رةأالفعلى  العجلةهي باستخدام  اللوصول لهم

 على الرسومات نفسها. تأثيرعرض فقط وليس لها  أوامر

  التكبير والتصغيرZOOM  للأعلىلف العجلة فعند  ،المكبرأداة كداة الأوتعمل هذه 

الأمر  استدعاء بالإمكان ذلك. كستصغر حجم العمل للأسفللفها عند ستكبر و

 .Zبالضغط على الاختصار 
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 التحريك  أمرPAN  بالضغط على  ذلكو ،تمكنك من التحرك يمينا وشمالاداة الأ وهذه

 علىبالضغط الأمر  استدعاء بالإمكان ذلكك .العجلة مع الاستمرار والتحريك

 .Pالاختصار 

 .نك من رؤية كامل العملالضغط مرتين على العجلة وستمك بالإمكان ملاحظة

 
 .الهندسية للرسومات التفاصيل بعض لرؤية( التقريب) تكبيرال بالإمكان( 29 -1شكل )

 طريقة التحديد

 :لليسارو أحين نضغط على نقطة وننتقل سواء لليمين  ذلكو ،من التحديدن انوعهناك 

  لون ن أوالتحريك للجهة اليسرى سنجد  ةمعينعند اختيار نقطة  ذلكو ،خضرالأالتحديد

في الصورة تلمس هذا التحديد سيتم  OBJECTعنصر ي أن أيعني  اوهذخضر أالتحديد 

 .اختيارها للعمل

  لون ن أوالتحريك للجهة اليمنى سنجد  ةمعينعند اختيار نقطة  ذلكو ،زرقالأالتحديد

بتغطيته لا إ OBJECTعنصر ي أيمكن تحديد  لا هنأوهذا يعني  ،زرقأالتحديد 

 .كاملا بالتحديد
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 .التحديد نواعأ( 30 -1شكل )

 VIEWالتحكم بالنوافذ من قائمة 

الذهاب  بالإمكان ولإعادتها ،حد النوافذ الموجودة بالبرنامجأغلاق إمن الشائع جدا 

بعضها خاص  ،المختلفةوستجد هناك جميع الخيارات المتاحة للتحكم بالنوافذ   VIEWلقائمة 

 .بعادثلاثي الأخر والآ بعادبنظام الرسم ثنائي الأ

 

مكعب خفاء إبالبرنامج عليك  وكمبتدئالعمل ثناء أالضرورية مور الأمن  ملاحظة

 . zي حداثليجنبك الرسم على الإ ذلكو CUBE VIEW بعادالرسم ثلاثي الأ
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 .بها الخاص والزر نافذة كلإلى  الصورة تشير( 31 -1شكل )

 KEYBOARD  لوحة المفاتيح

  فإن لذا ،ليالآفي تســريع عملية الرســم باســتخدام الحاســب    اًمهم اًلوحة المفاتيح تلعب دور

ــيوفر عليك    ــارات ســــ ــتفادة من الاختصــــ هم  ألنتعرف على  .العملثناء أكثير من الوقت الالاســــ

 المفاتيح الخاصة بها.

 
 .فيها المهمة المفاتيحو المفاتيح لوحة( 32 -1شكل )

وبعد   ،رقامالمدخلة والأ وامرالأوالذي يفعل  ،المفاتيحهم أوهو من  Spaceمفتاح المســـــــــــــــــــافة 

بالزاوية العليا لليســــــار على لوحة المفاتيح وهو للخروج من  Escنضــــــغط على زر هروب  ءالانتها

 .مرالأ
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   وامرالأالتراجع عما كتبته بشريط و أ وهو لحذف العنصر المحدد Backspace/Deleteمفاتيح 

Command. 

ــارة الإ تكما تم ــوع  شــ ــبقا حول موضــ ــاروتوكاد الأفي برنامج أداة لكل ن أبمســ   اًاختصــ

ســواء كان بكتابة  أداة انب كل هذا الاختصــار جيجاد إ بالإمكانن أو ،يمكن الوصــول له

 نفسها.داة الأكتابة اسم و أحرفين و أحرف ول أ

( وتعني الفاصـلة الرقمية بين   . )هناك نوعين من الفواصـل وهما  ن إلى أنود التنويه  ذلكك

ــف تكتب  كمثال رقامالأ ــتخدم لغرض )،ولكن  1,50متر ونصــ ــع الإا( تســ  مثلي حداثلوضــ

(X,Y)  بالتفصيل. ذلكوسنتكلم عن 

  ،بســهولة رقامالأإدخال لغرض  فتســتخدم NUMBER PAD رقاملوحة الأإلى  بالنســبةما أ

 الحاسب المحمول.  جهزة أمنه وتوجد ببعض يمن الألوحات المفاتيح على الجزء  بأغلبوتوجد 

 

مما  رقامعلى لوحة الأ NumLockبالضغط على زر ن والمتدربئ يخطما  اًكثير ملاحظة

 .فتنبه بالضغط على الجزء الخاص بتفعيل الكتابة به ،يعطل خاصية الكتابة

 

 :وأهمهاالمساعدة  وامرالأهذه المجموعة تساعد على تفعيل  :Fمجموعة مفاتيح 

 F8  فقيةأوسية أبرللرسم. 

 F9  يتحرك بشكل رة أالفشائع بالضغط عليه مما يجعل مؤشر  )خطأتفعيل الشبكة

 .غريب(

 F3  المساعدة تبالأدوا القفز/المغنطةتفعيل. 

 

  Unitsالقياسوحدة 

من وحدة القياس المستخدمة فلها علاقة   تأكدالمشروع رسم هندسي يجب      ي أبقبل البد 

 :بالآتيفلتغيير وحدة القياس بعد فتح مشروع جديد نقوم  ،بين الرسم وصحة الرسم وثيقة

  من قائمة البرنامج> Drawing Utility > Units  

 (وأ)

 أمر  من خلالCommand  حرفين من كلمة ول أإدخال بUnits  (UN)  ثمEnter 
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الأمر ونلاحظ ظهور  Commandفي شريط الـ الأمر وحدة القياس عن طريق كتابة لأمر ( الوصول 33 -1شكل )

 .Units (un)حرفين من كلمة أول إدخال بعد أولي في الشريط كمقترح مباشرة 

 

 
 .البرنامج قائمة من القياس وحدة لتغيير( 34 -1شكل )
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 .المتر هنا القياس وحدة مثلا المطلوبة القياس لوحدة الخانتين هاتين تغيير( 35 -1شكل )
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 تمارين الوحدة

 .(الأسبوع الأول، اسم المتدرب،  1حفظه باسم ) المشروع او مشروع جديدبإنشاء قم  .1

 .ثم احفظ الملفمتر إلى  قم بتغيير وحدة القياس .2

 .م 2ارسم دائرة نصف قطرها  .3

 .م 5طول ضلعه  اًارسم مربع .4

 احفظ الملف باسمك ورقمك التدريبي. .5
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 نموذج تقييم المتدرب لمستوى أدائه

 تمارين الوحدةالانتهاء من يعبأ من قبل المتدرب نفسه وذلك بعد 

قيم نفسك  AUTOCADاستكشاف واجهة برنامج وحدة بعد الانتهاء من التدرب على 

وقدراتك بواســـطة إكمال هذا التقييم الذاتي بعد كل عنصر من العناصر المذكورة، وذلك 

( أمام مستوى الأداء الذي أتقنته، وفي حالة عدم قابلية المهمة للتطبيق ضع بوضع عـــــلامة )

 ة الخاصة بذلك. العلامة في الخان

 العناصـــــر م

 مستوى الأداء )هل أتقنت الأداء(

غير قابل 

 للتطبيق
 كليا جزئيا لا

1  
القدرة على فتح البرنامج والتعرف على قوائم البرنامج 

 .الرسم والتعديل وحفظ العمل أوامرو
    

     .هندسية بسيطةأشكال رسم على القدرة   2

      .شكال الهندسيةلأالقدرة على التعديل على ا  3

     .التعرف على الطبقات  4

     .تجهيز ملف بدء المشروع  5

أو  درجة الإتقان الكليإلى  يجب أن تصل النتيجة لجميع المفردات )البنود( المذكورة

"جزئيا" فيجب إعادة التدرب أو  أنها غير قابلة للتطبيق، وفي حالة وجود مفردة في القائمة "لا"

 النشاط مرة أخرى بمساعدة المدرب.على هذا 
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 نموذج تقييم المدرب لمستوى أداء المتدرب

 تمارين الوحدةالانتهاء من يعبأ من قبل المدرب وذلك بعد 

 ...............................................اسم المتدرب : 
 

 ..............................التاريخ: 

 ..............................................رقم المتدرب  :
 المحاولة :

 العلامة: 

1 2 3 4 

... ... ... ... 

 نقاط 10مفردة يقيم بـ أو  كل بند

 من مجموع النقاط. %100الحد الأعلى: ما يعادل      من مجموع النقاط. %80الحد الأدنى: ما يعادل 

 بنود التقييم م
 المحاولات(النقاط )حسب رقم 

1 2 3 4 

1  
القدرة على فتح البرنامج والتعرف على قوائم 

 .البرنامج وأوامر الرسم والتعديل وحفظ العمل

    

     .هندسية بسيطةأشكال رسم على القدرة   2

      .شكال الهندسيةلأالقدرة على التعديل على ا  3

     .التعرف على الطبقات  4

     .تجهيز ملف بدء المشروع  5

     المجموع

 ملحوظات:   

............................................................................................................ 

............................................................................................................ 

 المدرب: .............................توقيع 
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 الثانيةالوحدة 

 أوامر الرسم والتعديل
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 الوحدة الثانية

 الرسم والتعديل أوامر

  العام للوحدة: الهدف

إكساب المتدرب المعارف والمهارات الأساسية لأوامر الرسم إلى  تهدف هذه الوحدة

  والتعديل.

  التفصيلية: الأهداف

 :أن علىوبكفاءة  وقع في نهاية هذه الوحدة التدريبية أن يكون المتدرب قادراًتمن الم

 .يشرح رموز الخطوط المختلفة .1

 .المختلفة الأوامرباستخدام على الرسومات يعدل  .2

 .ي المطلقحداثيرسم باستخدام الإ .3

 .يرسم باستخدام الشبكة المساعدة .4

 .هعلي الأوامرصغير ويطبق  اًيرسم مسقط .5

 ساعات تدريبية. 20 على هذه الوحدة: بالمتوقع للتدريالوقت 

 الوسائل المساعدة: 

 .A5دفتر مربعات بحجم  .1

 .قلم .2

 .الحقيبة التدريبية .3

 .مع ملحقاتهلي آجهاز حاسب  .4

 .جهاز عرض بياناتو أشبكة تعليمية  .5
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 الرسم

 مقدمة

الخاصة الأوامر النوافذ العامة للبرنامج وطريقة التحكم ببعض ول الأتعلمنا في الفصل 

بالتحرك داخل البرنامج. كذاك تعلمنا كيفية فتح وحفظ ملف جديد وتجهيز سطح العمل لبدء 

 الرسم.

 سنتعلم في هذا الفصلذا ام

 . Line & rectangles رسم الخطوط المستقيمة والمستطيلات .1

 .  Cancel, Erase/Delete & undo  وامرالأوالتراجع عن  مسح/حذف لغاءإ .2

 .Coordinate system  الشبكياستخدام النظام  .3

 .Circles& Arcs  قواسوالأرسم الدوائر  .4

 . Fillet & chamferأمر  استخدام .5

 . Block التعامل مع الكتل .6
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 الرسم أوامر

الهندسية المدمجة التي شكال والأالرسوم الهندسية هي عبارة عن مجموعة من الخطوط 

التخصص والمهنة. فمعرفة معنى كل خط على لوحة الرسم معينة لدى أصحاب  معانٍإلى  ترمز

 ما الذي يشير إليه. فلا تعرفلا معنى لخط  ،ضروري جدا قبل الشروع برسم الخط

 

  Lineمرلأا

الطرق  أكثرولكن سنذكر  ،خط لإنشاءطرق مختلفة  ةعدهناك وتوكاد الأفي برنامج 

 شيوعا.

  Home > Draw> Line ىانقر عل الرئيسةقائمة المن  مرلألللوصول  .1

 

 .()المسافة Spaceأو  Enter ثم L استخدام لوحة المفاتيح بالضغط على مفتاح نمكاو بالإأ

للرسم ويطلب منك تحديد أمر  نهإلى أشكل المؤشر تغير ليصبح + وهذا يشير ن أنلاحظ هنا 

يجب عليك  هنأفيد بت Command رسالة في شريط الـنشاء إتم  هنأنلاحظ  ذلكك للبدء،نقطة 

 تحديد نقطة البداية.

LINE Specify first point: 

ولى الأبعد تحديد النقطة  العمل،لتحدد مكان نقطة البداية على منطقة يسر الأاستخدم الزر 

 الرسالة التالية:إلى  ستتغير الرسالة

Specify first point or [Undo]: 

 المسافة بشكل مباشر إدخال ثم  تريده،اتجاه ي لأبتحريك الفأرة  ذلكو تحديد الاتجاه .2

 Enter  ثم -قد اخترت وحدة القياس المناسبة للرسم من أنك تأكد .3
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 بأسفلوهو الشريط  Command prompt تعلق في شريط الـ لاأ تأكد ملاحظة

 من الكتاب. في هذا الشريط دائما ماول الأتم ذكره في الفصل  ،الصفحة

ضافية إالتي تعطيك خيارات  وامرالألنا بعض التفاصيل تخص ظهر ت

في الأمر  ولكن هذه الخيارات قد تحيلك عن تنفيذ ،تساعدك على الرسم

للاستمرار بالمدخلات  Enter حال الغفلة عنه. لذا عليك بالضغط على زر 

 .Esc لأمرالخروج باو أ

 

سنرى شريط الكوماند يظهر رسالة  Lineأمر  إدخالعلى سبيل المثال عند 

 .بهذه الطريقة

LINE Specify first point: 

البرنامج  أوامرمن أمر  ... فلكلولى الأعليك تحديد النقطة ن أبوالتي تعني 

يعيقك عن الاستمرار سلا إوالتفاصيل بهذا الشريط هذه إلى نتباه بالاعليك 

 .بالعمل

 
 .الخط تجاها يوضح وهمي خط وظهور ولىالأ النقطة إنشاء طريقة يوضح( 1 -2شكل )
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 أكثر رسمه تم الذي الخط نأ انتبين مختلفتين سماكتين هناك نأ ولالأ الخط نشاءإ بعد هنأب نلاحظ( 2 -2شكل )

 .والزاوية المسافة مثل الجديد للخط مرافقة بيانات هناك نأب ذلكك ،بعد يرسم لم الذي الخط من سماكة

( 1-2شكل )بالولى الأبالصورة  ما تمن أستلاحظ  مختلفة،التحريك باتجاهات  بالإمكانن الآ

نلاحظ ( 2-2شكل )بالما أ LINE Specify first point هو تحديد أول نقطة

قيمتها من إدخال والتي يمكن  Specify next point الثانيةيطلب منك النقطة نه أب

 خلال لوحة المفاتيح.

هناك بيانات ملازمة وتختلف هذه البيانات باختلاف ن أنلاحظ  (3-2)على الشكل  .4

يدويا من دون استخدام الفأرة تساعدك دخالها إهذه البيانات التي يمكن و ،الاستخدام

 .رقامعلى الحفاظ على تعامد الخطوط والأ

 
 اللون ماأ ،الزاويةإلى  يشير  0 ° بالمنتصف الرمادي اللون ،بالمتر ةالمسافإلى  يشير 3,88 زرقالأ اللون( 3 -2شكل )

 في نفسها الصياغة باستخدامالأمر  كتابة ويمكن واحد نآ في الزاوية مع المسافةإلى  شيري Polar:3.8845<0°  الرمادي

 .وامرالأ شريط
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ول الأقد رسم الخط كون يرة سأيسر للفالأبعد تحديد النقطة الثانية بالضغط على الزر  .5

باستخدام نهاء و بالإأالخطوات نفسها  بإعادةوسيطلب منك البرنامج تحديد نقطة لاحقة 

 .Esc بالضغط على زرداة استخدام هذه الأنهاء إو أ Enter ثميمن الأالزر 

وسيتراجع  U التراجع باستخدام مفتاح بإمكانكصحيحا دخالك إفي حال لم يكن  .6

 .دخالالإعن 

التراجع أداة الاستفادة من  بالإمكانعدد من الخطوات إلى في حال الرغبة بالرجوع  .7

 حيث تتيح لك هذه القائمة التراجع لليسار،الزاوية  بأعلى Quick barوالتقدم بشريط 

 Control واختصارها Undo مما تسهل لك العمل. وللتراجع ،عدد من الخطوات والتقدم إلى

+Z وللتقدم Redo باختصار Control +Y ، يقونتين على قائمة منسدلة الأ لاكتحتوي

عنصر ي أوتستفيد منها في حال تم حذف  ،من التراجعات اًتظهر لك عددوتساعدك 

 .خطأً

 

 .Redo والتقدم Undo التراجع الأمرين يوضح Quick bar الـ شريط( 4 -2شكل )

 Orthoاستخدام وضع التعامد 

يعتمد بشكل رئيس على الخطوط المتعامدة فمن العملي استخدام الرسم الهندسي المعماري 

 .فقيةأسية وأر اًلترسم خطوط F8 واختصارهاالشاشة سفل أوالتي نجدها  Ortho خاصية الـ

 

 .وامرالأ سطر في Ortho دالتعامأداة ( 5 -2شكل )

 



 مبادئ الرسم بالحاسب

 

 رسمع 011

 

 
45 

 يات حداثالرسم باستخدام الإ

تخدام لوحة والثانية باسرة أشارة الفالإيلة باستخدام وسولى الأيتم الرسم بإحدى الطريقتين 

ضيح لهاتين وفيما يلي تو ،ي المطلقحداثدام الإوفي كلتا الطريقتين يتم الرسم باستخ ،المفاتيح

 .الطريقتين

 الفأرة باستخدام 

النقطة المطلوبة إلى  ك المؤشرليتحررة أالفبتحريك  ذلكيتم الاعتماد بالرسم الجرافيكي و

يات حداثوفي هذه الحالة يقوم البرنامج بتحديد الإ للاختيار،رة أالفمن يسر الأثم ضغط الزر 

 شيوعا. كثروالأسهل الأمواصلة الرسم منها. وتعتبر هذه الطريقة و أالمناظرة لهذه النقطة وبدء 

 باستخدام لوحة المفاتيح

مفتاح على النقطة المطلوبة ثم الضغط إلى  ليتحرك المؤشرسهم الأبتحريك مفاتيح  ذلكويتم 

إدخال عن طريق و أ النقطة،يات المناظرة لهذه حداثمسافة ليتم اختيار الإ وأ دخال الإ

 .دخالالإيات ثم الضغط على مفتاح حداثالإ

 اختيار النقاطو أتحديد 

ن أوسبق  لوحة المفاتيح،و أشارة إيمكن تحديد النقاط على الشاشة باستخدام وسيلة 

 يات النقاط من خلال لوحة المفاتيح ثم الضغط على إحداثقيم إدخال يمكن نه أذكرنا 

 يات من خلال لوحة المفاتيح وهي:حداثويوجد ثلاث طرق لكتابة الإ

 Absolute Coordinatesي المطلق حداثالإ

إدخال ب ذلك( و0,0)صل الأنقطة إلى  يات النقاط منسوبةإحداثإدخال ي يتم حداثوفي هذا الإ

 .بالتفصيل ذلكسنشرح  0,0عن النقطة  X,Yبعد النقاط في الاتجاهين 

 Relative Coordinatesي النسبي حداثالإ

نه أوهذا يعني  السابقة،النقاط إلى  يات النقاط منسوبةإحداثإدخال ي يتم حداثوفي هذا الإ

 .X,Yبعد النقطة عن النقطة السابقة لها في الاتجاهين إدخال يتم 
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 Polar Coordinatesي القطبي حداثالإ

سب حيث تن ،ي النسبيحداثفس طريقة الإيات النقاط بنإحداثي يتم وصف حداثوفي هذا الإ

 عن النقطة يد طول الخط والزاوية الميل بديلًاولكن يتم تحد ،دخالهاإنقطة تم خر آإلى  النقطة

 .X,Yفي الاتجاهين 

 وصف الزوايا

بكتابة قيمة الزاوية من خلال لوحة المفاتيح بالقيمة وتوكاد الأويتم وصف الزوايا في برنامج 

بنظام الدرجات قيمة الزاوية و أ والثواني،عن طريق الدرجات والدقائق و أ ،Decimalالعشرية 

 بالتقدير الدائري.و أ درجة، 360°

اتجاه أو  ويتم قياس الزوايا الموجبة في اتجاه عكس عقارب الساعة ابتداء من اتجاه الشرق

 الساعة،هذه الزاوية تقاس في اتجاه عقارب ن إفقيمة الزاوية بالسالب إدخال وعند  Xالمحور 

 .خرىأقيمة ي أبوالبرنامج يفترض القياس بالقيمة العشرية حتى يتم تغييرها 

 يات:حداثأنواع الإ

 . Absolute Coordinates  ي المطلقحداثالإ .1

 . Relative Coordinates  ي النسبيحداثالإ .2

 . Polar Coordinates  ي القطبيحداثالإ .3

  Polar Coordinatesيات القطبية الافتراضية حداثالإ

لرسم  مما تستخدوغالبا  ،تستخدم هذه الطريقة لرسم الخطوط ونسخها ونقل العناصر

ولكن قبل البدء في شرح هذه الطريقة  والزاوية،بتحديد مسافة الخط  ذلكو المائلة،الخطوط 

 .(6-2)الافتراضية من خلال الشكل عدادات الإيجب التعرف على 
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 .وتوكادالأ في الافتراضي الزوايا نظام( 6 -2شكل )

ولكن علينا مراعاة  ،السالبو أالبيانات سواء بالموجب دخال لإهناك طريقتين ن أنلاحظ 

ولكن تكون سالبة مع  ،كانت عكس عقارب الساعةن إتكون موجبة دخال الإطريقة ن أ

فتكون الطريقة  °60م وبزاوية  4خط مستقيم بطول إدخال كنا نريد إذا عقارب الساعة. ف

 كالتالي:

 .Lبالضغط على مفتاح   Lineمرلأاختيار ا .1

 .رةأيسر للفالأبالضغط على الزر ولى الأتحديد النقطة  .2

 . @60>4 ةالصيغة التاليإدخال  .3

 (.7-2)الشكلتم الانتهاء من عمل الخط المطلوب انظر  .4

 م   0.15× م 3 شكل مستطيل بمقاس تمرين رسم مستطيل

 .Lبالضغط على  ذلكو Line مرلأفلنختار افي البداية  .1

نه إ( حيث 0,0) هيفلنقل بأن نقطة البداية  ،الرسمة امنه ستبدأتحديد النقطة التي  .2

 . yوالعدد الثاني هو  xفهو ولا أعدد يدخل ي أ (x,y)يكون بهذا النسق 

دخال الإطريقة كون تف ،المسافةإدخال ب نبدأولى الأفبعد تحديد مكان انطلاق النقطة  .3

 كتالي:

 0>3@  .أ
 90>0.15@ .ب

 0 وضع الزاوية بالإمكان 180>3-@ .ج

 90->0.15@ .د
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 Esc بالضغط على زرالأمر  نهاءإبعد الانتهاء يتم  .4

 

 

 .درجة 60°إلى  0° زاوية من ليتحرك خط تحديد( 7 -2شكل )

هي عبارة عن شبكة وتوكاد الأصفحة برنامج ن ذكرنا أول الأفي الفصل  ياتحداثبالإالرسم 

بيانات إدخال . هذه الطريقة تساعدنا على Yوالمحور   Xيات وتكلمنا عن المحور حداثمن الإ

ي باستخدام المؤشر وبالاعتماد على أدخال الجرافيكي )يات بعيدا عن الإحداثباستخدام الإ

 المعلومات المدخلة سلفا(.

 يات: حداثباستخدام الإفلنعد التمرين السابق ولكن هذه المرة 

 م   0.15 ×م 3 مستطيل بمقاس

 . Lبالضغط على  ذلكو Line مرلأفي البداية فلنختار ا .1

نه إ( حيث 0,0) هينقطة البداية ن إفلنقل  ،الرسمة امنه ستبدأتحديد النقطة التي  .2

 . yوالعدد الثاني هو  xفهو ولا أعدد يدخل ي أ (x,y)يكون بهذا النسق 

  :ي حسب المعطياتحداثالإإدخال ب نبدأولى الأفبعد تحديد مكان انطلاق النقطة  .3

 . 3,0قيمة إدخال ب ذلكاليمين وإلى  0,0الانطلاق من نقطة المركز  .أ

ن أبوقفة وهي إلى  نحتاج وهنا 0.15القيمة إدخال ب ذلكوعلى الأإلى  الانطلاق .ب

 ذلكو 0.15المدخلات هي  ولكن 3.15 يحداثالناتج من هذه النقطة هو الإ

 . y=0.15بقيمة بعد تالنقاط المدخلة ن أبسبب 

 .(3,0-)  قيمةإدخال ب ذلكاليسار وإلى  الانتقال .4

 . (0,0.15)القيمة إدخال ب ذلكو أسفلإلى  النزول .5
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 . Escو أ cبالضغط على الزر  ذلكوغلاق الإ .6

على سبيل المثال  بالإمكانوتوكاد الأكسور في برنامج إدخال في حال  ملاحظة

 بالإمكانولكن  0.15بهذه الطريقة دخالها إمسافة نصف متر فيتم 

وهذا بشكل  15.الفاصلة بشكل مباشر إدخال بالاختصار على نفسك 

 العمل.داء أتدريجي يزيد من سرعة 

 

 

 . Command وامرالأ بشريط بإدخاله عليك وما المسافاتإدخال ( 8 -2شكل )
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 تمرين

في  أسرعطرق يجاد إالهندسية التالية بالطريقة التي تناسبك مع محاولة شكال الأارسم 

 كل المهام.نجاز إ
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 الرسم باستخدام الشبكة المساعدة

للرسم تعتمد على  اًوهنا سنذكر طرق يات،حداثبالإبالرسم  اًن هناك طرقأذكرنا ب

 .Snapالقفز و أالمغنطة  أمرو Gridالشبكة المساعدة 

 Grid الشبكة المساعدة

عبارة عن شبكة تتواجد في جميع برامج الرسم والتي تساعدك  Gridالشبكة المساعدة 

ظهارها إو أها ؤخفاإتقدير حجم الرسم بشكل سريع. ويمكنك و أعلى تسهيل عملية الرسم 

على الرسم وتسهيل ساعدك يالشبكة مما إلى  Snapأمر  دمج بالإمكاننه أ. كما ذلكردت أن إ

 .أكثرالمهمة بشكل 

 Gridأمر  تفعيل

 .F7بالضغط على مفتاح  ذلكو

 .Ctrl + Gبالضغط على مفتاح  ،(وأ)

 أيضا.المساعدة للوصول له  وامرالأكما يمكنك بالضغط على شريط 

 
 موضح هو كما المساعدة   وامرالأ بشريط ودجمو  F7 اختصاره والذي،  GridModeلـ المساعدالأمر  (9 -2شكل )

 .بالصورة

 ،كما يمكن تعديل الشبكة لتكون بالمسافات التي تتناسب مع نوع العمل الذي تقوم به

يكون حجم  ةوتارتكون هناك تقسيمات كبيرة ن أفتارة يكون عملك بدقة عالية فيحتاج 

 ليمثل كل مربع نصف متر بعادعند رسم مخطط فمن العملي وضع الأ كمثال اً،الرسم كبير

إلى  ولى بدون الحاجةأعلى سبيل المثال من نظرة  )الغرففيساعدك لتقييم حجم العمل  مترأو 

 حساب المسافة. 
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كما في   Grid Setting يمن ثمالمساعدة بالزر الأ وامرالأيقونة أعلى  انقرولتعديل المسافة 

 .(10 -2شكل )ال

 
 عداداتإإلى  تدخلك والتي Grid Setting باسم قائمة لك ستظهر بالفأرة يمنالأ بالزر بالضغط( 10 -2شكل )

 .الأمر

 ،تدخل القيم المرادة التي تكون بين الخطوطن أ بالإمكانتفتح لك قائمة القفز ن أبعد 

كون تن أب وتأكد  0.5×0.5عبارة عن مربع بمقاس  ةالشبكن أففي الشكل التالي نلاحظ 

 .ثناء العملألبس ي أ للكيلا يحصمتماثلة  Gridوالـ  Snapبشبكة الـ 

 .التغييرات لتأكيد OKثم اضغط على زر 

 

 

 . Grid Settingأمر  عداداتإ قائمة( 11 -2شكل )
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 Snapالمغنطة / القفز  أمر

من قبل المستخدم يسمح للمؤشر بالقفز دخالها إيتم  أبعاديحدد لك شبكة ذات أمر  هو

 ولا يلزمالمساعدة في الرسم الأوامر من  ويعتبر Y يحداثوالإ  Xيحداثبمسافة محددة في الإ

 استخدامه.

 Snapمرالأتفعيل 

 .F9بالضغط مباشرة على مفتاح 

 .Ctrl + Bبالضغط على مفتاح  (وأ)

 .Gridأمر  المساعدة جانب وامرالأشريط  على  Snapزربالضغط مباشرة على  (وأ)

 وحدة. 40صغير( في  )مربعوحدة  30لعمل مستطيل بمساحة  تمرين

 المعمارية.الرموز المعمارية التي تستخدم في المساقط 

 فأيضاً ،هندسية مختلفةشكال أتمكننا من صنع وأنها  Lineأداة تعلمنا على ن أبعد 

ربما لم  تدواأمختلفة بشكال أ لإنشاءداة الاستفادة من طريقة استخدام الأ بالإمكان

وعليك  تدريجيا،العامة وسنتوسع  والأفكارالرسم  مبادئلذا سنركز على  ،تستخدمها من قبل

النتيجة إلى  عليك لتصلسهل الأ وما هتجرب خيارات مختلفة لتجد ن أالمتدرب يها أعزيزي 

 مجموعة من الرموز المعمارية.مامك أالشكل التالي لتجد إلى  المطلوبة. انظر
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 .المعمارية المساقط في المستخدمة المعمارية الرموز من مجموعة( 12 -2شكل )
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 م 0.15بحيث يكون سمك الدرفة  م1.20مسقط باب درفة واحدة بعرض  مارس :تمرين

 :خطوات التنفيذ

نفس الطريقة ولكن إلى  من الطرق التي تعلمناها فهي تؤديي أاختيار  بالإمكان ملاحظة:

 .الرسم الشائعة هنا وهي باستخدام الفأرةطريقة سنعتمد 

  اً.جديد اًافتح مشروع .1

 .ر وحدة القياس لتكون المترغيِّ .2

  .على لوحة المفاتيح Lبالضغط على أو  Lineأمر  باختيار ذلكالرسم و أابد .3

 .  0,0حدد نقطة البداية فلتكن المركز  .4

 . F8الاستقامة أمر  من تفعيل تأكد .5

 ة:التالي بعادبالأ ارسم مستطيلًا .6

 . 1.20على لى الأإ .أ

 . 0.05اليمين لى إ .ب

 .  1.20سفللى الأإ .ج

 .غلاقللإ Cضغط على مفتاح أو  0.05اليسار لى إ .د

 .لدينا مستطيل أصبحن الآ

 .Draw>Arc>3-Pointمن قائمة    Arcالجديد وهو الأمر  فلنختر .7
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 . Point-3 اختر له المحاذية القائمة على اضغط ثم Draw>Arc قائمة من( 13 -2شكل )

 التالية:ستظهر لنا الرسالة 

 Specify start point of arc or [Center]: 
 

تحديد ي أ Cفنختار  ،القوستحديد مركز أو  للقوسولى الأعليك تحديد النقطة ن أوتعني 

 .المركز

 .تحديد الزاوية العلوية لليمين للحصول على ربع دائرة تمثل اتجاه فتح الباب .8

 .Esc على بالضغطالأمر  ننهي .9

 

ــافيةإيتيح لك خيارات يمن الأالزر  ملاحظة ما الذي  اًفي حال كنت متحير :ضـــــــــــــــــ

ــغط على الزر اليمين ليتيح لك عدد بالإمكانيتوجب عليك فعله  من  اًالضـــ

فعلى ســبيل المثال بالمثال الســابق كان عليك الضــغط على الزر     الخيارات،

C  إدخال بالإمكانلك ذكلتحديد القوس ليكون من المنتصـــــــف ولكن 

والذي  Centerثم اختيار Right-Click يمن الأعلى الزر  بالضــــــــــغطالأمر 
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 Enterالضـــــــــغط على زر  بالإمكان ذلكنفس النتيجة. كإلى  ســـــــــيؤدي

 .يمنالأزر العلى  بالضغط

 
 الزربالضغط على ( 14 -2شكل )

 قائمة في المتاحة الخيارات لك يتيح يمنالأ

Command اختيار بالمثال هو ما مثل 

 المتاحة الخيارات حدأ وهو Centerأمر

 . Arcللأمر

 
 يمنالأ الزر على بالضغط( 15 -2شكل )

أو  التراجعأو  به قمتأمر  خرآ اختيار لك يتيح

 حاسبة لةآ وجود نلاحظ ذلكوك التقدم

QuickCalc. 

 

 Objectتحديد العنصر

وتمثل في باب  اًمصغر اًطبقنا مشروعن أبعد ن والآعن التحديد ول الأتحدثنا في الفصل 

 التعديلات التي تساعدنا وتخدمنا في عملية الرسم.بعض جراء إسيتوجب علينا 

 تحديد العنصر  .أ

  هذا التحديد سيخولك ن أي أ بتحديده،جزء من الخطوط سيقوم البرنامج ي أبالضغط على

ت زرق وظهرالأالعنصر المحدد تحول للون ن أنلاحظ  ،تعديلات على هذا الخطي ألتجري 

بالمنتصف كما  وواحدبثلاث مربعات زرقاء صغيرة اثنين لكل طرف  ةعليه ثلاث نقاط متمثل

 .(16 -2شكل )بالفي 

 الضغط على زر  بالإمكانالتحديد  لإزالةEsc. 
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 .تحديد جزء من الباب (16 -2شكل )

 ةمباشرالضغط على العنصر  بالإمكانالتحديد إلى  ضافةلإل. 

 الضغط على مفتاح  بالإمكانالعناصر المحددة حد أ لإزالةShift + زالة إالمراد  راختيار العنص

 .( جوار المؤشر( -حظ ظهور رمز ) لاوسن ا،التحديد منه )الضغط يكون مستمر

 
 التي العناصر فقط فيحدد زرقالأ التحديد ماأ ،يلمسه ما كل يختار خضرالأ التحديد: التحديد نوع( 17 -2شكل )

 .بالكامل يغطيها

  تحديد العناصر بالاستفادة من نوع التحديد بالإمكان هنأول بالأما تم شرحه في الفصل. 
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 Moveالتحريك 

بعض التعديلات جراء إتحريك العناصر التي تم تحديدها بالبرنامج والتي تتيح لنا  بإمكاننا

 المناسبة للمشروع الذي نقوم به.

 .تحريكه()التعديل عليه جراء إبعد تحديد العنصر المراد  .1

بالكبس على مفتاح أو  Home> Modify> Move  وامرالأمن قائمة  نختاره .2

M. 

 هذه الرسالة:  Commandـستظهر لك في قائمة ال .3

Specify base point or [Displacement] <Displacement:> 

ب يجالتي ستحرك منها هذا الشكل المحدد هنا وولى الأيد النقطة دعليك تحن أبوالتي مفادها 

 :الأمورالتنبيه لعدد من 

ــيلزمك البرنامج  F8كما عرفناه التعامد أو  Orthoأمر  تفعللو كنت قد  .أ ســـــــ

أو   Xي حداثالإ )فيولى الأمع النقطة  متوازٍبشــــــــــــــكل متعامد لا إ كتتحر ألاب

 .(Yي حداثالإ

سيمكنك  F3المغنطة أو  بالقفزكما عرفناه  Snapأمر  تفعلكنت قد ن إ .ب

 .الذي ينصح به دائما( )وهذاالعناصر المحددة طراف أمن اختيار طرف من 

ستتغير  Base Pointساسية الأالبرنامج بالنقطة سماها أولى والأبعد اختيار النقطة  .4

 :الرسالة التاليةإلى  الرسالة في شريط الكوماند

Specify second point or <use first point as 
displacement> 

 .ولىالأسينطلق من النقطة نه أبعليك تحديد النقطة الثانية وينبهك ن أبوالتي مفادها 

  :مرتحديد العنصر بعد اختيار الأ .ب

الأمر  ة تتغير حسبأرشارة الفن أونلاحظ هنا  ،لتتمكن من التحديد ةثانيوهذه طريقة 

+ والذي يطلب منك تحديد ل كبشالأمر  سيكون Drawكان من قائمة ن إالذي اخترته 

ولكن حين نختار  ،رةأالفتحديد النقطة باستخدام أو  ياتإحداثنقطة البداية باستخدام 

شرحه في  ما تم. وهذا  اًلتصبح مربع تشارة تغيرن الإأسنلاحظ  Modifyمن قائمة  اًأمر

 .ولالأالفصل 
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 :الخطوات

سنشرح اختصار ز ووالتي تتمثل برم Snap Objectوهنا نحن بحاجة لشرح معاني رموز الـ 

 بعضها.

 Snapالمساعد الأمر  نأسنلاحظ  Modifyأو  Drawسواء من قائمة أمر  يأبعد اختيار 

 19-2فمثلا بالشكل  ،معينشيء إلى  منها يشيرأمر  فكل ة،معيننقطة خذ أيساعدنا على 

في الخطوط. فحيثما تحرك المؤشر ستتغير  هناك تداخلًان أبالخضراء متمثلة شارة ن الإأنلاحظ 

شكل الانظر  Osnapالمتاحة التي تم تحديدها بقائمة خيارات الـ  وامرالأمن  مرلأالعلامة سواء 

هذه  أحديساعدك على الحصول على والذي معين أمر  استدعاء بالإمكانولكن  (18 -2)

ففي هذه الحالة  ،وتتداخل الخطوطحين تتعقد الرسوم  خصوصاًالخيارات التي قد تحتاجها 

  مكان استدعاءبالإ

 
 في شرحها تم ،المساعدة   وامرالأ قائمة على يمنالأ الزر خلال من لها تصل والتي Osnapالـ خيارات( 18 -2شكل )

 .ولالأ الفصل

ستظهر لك قائمة  Shift+ Right Clickيمن الأبالضغط على الزر  ذلكو وامرالأهذه  أحد

دعنا نحرك  ذلكولتطبيق  Osnapالمساعدة من قائمة  وامرالأحد أمنسدلة تطلب منك اختيار 

 .Endpoint الطرفدرفة الباب ولكن من 
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 .حدد الجزء الذي تريد تحريكه فلنقل نريد نقل المستطيل .1

 .Mباختصار أو  Moveأمر  نختار .2

 .Shift+Right Clickالكبس على  .3

 .Endpointاختيار من القائمة  .4

إدخال إلى  والذي يشير( 20 -2شكل )الشكل + كما في إلى  ن المؤشر تحولأنجد  .5

 .()المستطيلالباب  أطراف أحدإلى  حرك المؤشر ي،إحداث

 

 
 . Shift+Right-Click على الضغط خلال من لها تصل  Osnap الـ أوامر( 19 -2شكل )

 دتحد أنكإلى  والتي تشير( 21 -2شكل )بالمربع كما شارة إلنا  تظهر هنأسنلاحظ  .6

 .نهاية النقطة لتكون نقطة حركة العنصر

 من مرة لتتمرس عليه. أكثرب ذلكيمكنك تجربة 
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 . X ورمزها بالخطوط التداخل وتعني( 20 -2شكل )

 
 .  مربع ورمزه الخط نهاية رمزإلى  يشير وهذا( 21 -2شكل )
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أو  رةأالف بمؤشر يإحداث اختيار منك تطلب التي شارةالإ وهي+  شكلإلى  تحول المؤشر نأ نلاحظ( 22 -2شكل )

 .المفاتيح لوحة طريق عن يدويا دخالهاإ

  Block كيف تعمل كتلة

الدقيقة جزاء الأالمهمة عمل مجموعات لتسهل علينا التحكم ونقل الرسومات ذات مور الأمن 

عمل كتل لتتمكن من التعامل مع هذه  من العملي ذلكل واحدة،وتتعامل معها ككتلة 

 الرسومات كمجموعات.

 ....إلخ(ثاثالأ ،النوافذ ،بوابالأ) كتل:إلى  نحولهان أالتي يجب  العناصرعلى بعض مثلة أ

 ما.أمر ي ألست في وسط  أنكمن  تأكدلل Escلضغط على مفتاح با أابد .1

 .لها  Blockقم بتحديد العناصر التي تريد عمل  .2

 .Bبالضغط على مفتاح أو  Home>Block>Create Block   وامرالأمن شريط  .3

 .(23 -2شكل )الالبيانات كما في إدخال ستظهر لنا نافذة تطلب  .4
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 . Block Definition الـ قائمة( 23 -2شكل )

علينا سهل يلمنطقية ودالة على الشيء سماء الأتكون ن أنسمي البلوك ونحرص  .5

 D1فهنا سنسمي الباب  العمل،من سرعة  دما يزيوهذا  ،خرىأاستخدامها في مشاريع 

 .باب رقم واحدنه أبونقصد به 

 البلوك،نختار نقطة في طرف ن أبوينصح  ،نختار النقطة التي يمكن تحريك البلوك منها .6

سنتحدث عنها  ،الخاص بالبلوك لمركز العمهذه النقطة ستمثل ن إلى أويجب التنويه 

 لاحقا.

 ،التغيير هنا سيغير من حجم البلوكن إحيث  Block Unitتحتها سنجد وحدة قياس  .7

 .Meterالـ  مما نستخدفينصح دائما تركه بوحدة الرسم ونحن كمعماريين دائما 

وهذا الخيار فقط في حال لم تقم بتحديد العنصر  Select Objectsتليها تحديد العنصر  .8

تضمها ن أالتي تريد جزاء الأالضغط عليها واختيار  بالإمكانف ،قبل فتح هذه الشاشة

 .(23 -2شكل )انظر  ،لهذه الكتلة

بعض ففي  ،Descriptionشرح خاص بهذا البلوك في قائمة ضافة إ بالإمكانكما  .9

 كمثالمعين  بأثاثتضيف مقاسات خاصة ن أوتريد  ةمعينلشركة  اًثاثأترسم حيان الأ

 .بيضأسم نوع خشب مضغوط بلون 60×60مقاس طاولة شاي بمقاس  IKEAثاث أ

 .OKالكبس على زر موافق  .10
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 . PickPoint خيار خلال من حددناه الذي المكان يه اءالزرق النقطة نأ نلاحظ( 24 -2شكل )

 Copyالنسخ 

نسخ العناصر المكررة  فيحيث نستفيد منه  ،المهمة في البرنامج وامرالأالنسخ من  أمر

الغرف انظر إلى  حتى تصلأو  الشبابيكبواب الأمن دورة المياه جزاء أ كمثالبشكل كبير 

 .Move مرلأمطابقة تماما الأمر  هذاتنفيذ طريقة  ،(25 -2)الشكل 

 
.له الداخلية التوزيعات في متشابهة نوم غرف من مكون لفندق مسقط( 25 -2شكل )  

 :الخطوات

 ما.أمر ي ألست في وسط  أنكمن  تأكدلل Escبالضغط على مفتاح  أابد .1

 .Osnap أمر  من تفعيل تأكدحدد العنصر الذي تود نسخه و .2

 البداية.وستمثل كنقطة خه سنللعنصر الذي تود طراف الأ أحداختر  .3
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بالضغط على النقطة أو  المسافة مباشرةدخل أللاتجاه المراد النسخ له ثم رة أالفنحرك  .4

 .(26 -2)شكل انظر ال بشكل مباشر

 .ذلكمل ع انكمكإفبماكن أ ةلعدفي حال كنت ترغب بالنسخ  .5

 الرسالة.ستظهر لك هذه  ذلكبعد  .6

Specify second point or [Array/Exit/Undo] 
<Exit:> 

  :من الخيارات اهناك عددن أبوالتي مفادها 

 .عدد من النسخ المتعددة إنشاء وتعني Array  .أ

 .مرالخروج من الأ وتعني  Exit .ب

 نسخة تم النسخ لها.خر آوتعني التراجع عن  Undo .ج

 .Esc مفتاح الهروبو أالأمر  نهاءلإ Eفي حال الانتهاء اضغط على مفتاح  .7

 
 ة.الثاني النقطة باتجاه رةأالف تحريك ثم ومن ولىالأ النقطة تحديد عليك نأب بالشكل كما نلاحظ( 26 -2شكل )

 Block Editingتعديل الكتلة 

بالنقر على الكتلة مرتين وستفتح  ذلكو Blockتعديل على الكتل جراء إبالطبع يمكنك 

تغير لون الخلفية من اللون  ظما ستلاحول أ لك نافذة جديدة خاصة بالتعديلات على الكتل.

تعديل يتم داخل هذه ي أداخل نافذة تعديل البلوك.  أنكوهذا يعني  ،الون الرصاصيإلى  سودالأ

تحديد ما الذي تود  عليكب يجلذا  ،النافذة سينعكس على جميع العناصر المنسوخة من البلوك

 التراجع عنه. نلا يمكتعديل يتم ي أن أوتعديل ي أجراء إتعديله بدقة قبل 
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 الخطوات:

 ما. أمري أ وسط فيلست  أنكمن  تأكدلل Escبالضغط على مفتاح  اًابد .1

 .انقر مرتين على العنصر المراد تعديله .2

 ،المراد تعديله Blockاختيار الـوتطلب منك   Edit Block Definitionستفتح لك نافذة  .3

 ـ لا يواضحة لك بأسماء Blockلذا كما ذكرنا بالتمرين السابق من الضروري تسمية ال

 .عليك الرسومات لتتداخ

 
 البلوك اختيار من فتأكد المشروع هذا في تهاأنشأ التي Blocks الـ جميع ستظهر النافذة هذه في( 27 -2شكل )

 شرحه تم كما Description قائمة ضمن البلوك عن اًمبسط اًوشرح Preview طارإ ضمن للبلوك صورة ستجد ،المناسب

 .السابق التمرين في

 .Blockللدخول لنافذة التعديل الخاصة بهذه الكتلة  OKانقر  .4

الموجودة وامر الأالخلفية الرصاصية كما بالشكل وستكون لدينا كامل ن أنلاحظ  .5

 .وتوكادالأفي 
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 .التعديل أوامرب الخاصة التعديل نافذة من صورة( 28 -2شكل )

 .(28 -2شكل )بالهو واضح  جزء بالباب كماي أتعديل  بإمكاننان الآ .6

 . Close Block Editorبعد الانتهاء يمكننا حفظ التعديل بالضغط على علامة صح  .7

وتعني احفظ التعديل على الملف  Save the change to D1ول الأستظهر نافذة بخيارين  .8

D1  والخيار الثانيDiscard the change and close the Block Editor  تجاهل

 .نافذة التعديلاتغلق أوالتغييرات 

 

 .التغييرات حفظ (29 -2شكل )

من عنصر ستتغير  أكثرفي حال تم نسخ  –بالطبع بعد الحفظ ستتغير جميع النسخ  .9

 .جميعها
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 Explodeوتسمى تفجير  Blockإلغاء الـ 

مل ولع ،نشائهاإعادة إوتفجيرها  مكانبالإف ةمعينتعديل على كتل  بإجراء ترغبفي حال 

 :تيةالآاتبع الخطوات  ذلك

 ما. أمري أ وسط فيلست  أنكمن  تأكدلل Escبالضغط على مفتاح  أابد .1

 .Home>Modify>Explodeقائمة وتجده ضمن  انقر على الرمز  قائمةالمن  .2

 .حيث يمكنك تحديد العنصر المراد تفجيره إلى  سيتغير المؤشر ذلكبعد  .3

 .للإدخالمسافة أو  اضغط  .4

 .تمت عملية التفجير .5

  Toilet Seat   مثال: رسم مسقط مرحاض

التفصيلية جزاء الأهناك مقاسات ومراجع لرسم ن أ تأكدشيء على البرنامج ي أعند رسم 

فلذا ينصح باقتناء الكتب المرجعية لتساعدك على الرسم  ،تكون عبثية لاأويجب جهزة الألهذه 

 Architects' Data Neufertهناك العديد من الكتب وفي مقدمتها و ،بالشكل الصحيح

من الكتب المصورة لاحتوائه  وتوجد منه نسخة باللغة العربية ويعتبر Ernst Neufertللكاتب 

لتتمكن نجليزية الإللغة  انكإتق طلا يشتر أنهي أ ،بعادعلى صور عديدة موضحة للمقاسات والأ

 من الاستفادة منه.

  :الخطوات

أمر  باستخدام ذلكو ،فرنجيالإللسيفون  يلًاطتبرسم مستطيل والذي يمثل مس نبدأس .1

 .RECبالاختصار أو  Home>Draw>Rectangleوللوصول له من قائمة  المستطيل 

بالضغط  ذلكهذين الضلعين وإدخال لذا سيتوجب عليك  0.55×0.20السيفون بمقاس  .2

حيث  ) (x,yعلى هذا النسق  yثم  x الـي حداثالإإدخال ثم ولى الأعلى النقطة رة أبالف

 .ثم  0.55,0.2سيكتب بهذه الطريقة نه إ

 .وللوصول له سنقوم برسم الشكل البيضاوي  ذلكبعد  .3

4. Home>Draw> Ellipse  بالاختصار أوEL  بل قطار أنصاف إدخال أ دلا نري، ولكن

قم بالنقر على القائمة المنسدلة  ذلكبفللقيام  ،ندخل القطرين بشكل مباشرن أنريد 

 .نالآالذي سنستخدمه الأمر  وهو Axis, Endواختر الأمر  من
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 بالنقرأو  Osnapمرلأبتفعيل ا ذلكنحدد نقطة البداية للشكل البيضاوي ون أنريد ن الآ .5

 .Midpointومن ثم تختار  Shift + Right Clickعلى 

 .Command الـستظهر هذه الرسالة بقائمة  .6

 
 Midpoint( تحديد الـ 30 -2شكل )

Specify axis endpoint of ellipse or 
[Arc/Center] 

للشكل البيضاوي والذي سيكون بطول سي أالرلبداية القطر ولى الأوتعني تحديد النقطة    

 م0.2وهو فقي الأم ثم تحديد نصف القطر 0.55

 
 القطر طولإدخال  عليك سيتوجب البداية مكان على رةأبالف بالنقر ذلكوالأولى  النقطةإدخال  بعد( 31 -2شكل )

 البيضاوي الشكل قطر نصفإدخال  عليك ثم، البيضاوي للشكل المقابل الطرفإلى  سيوصلك والذي

خطوط إلى  بالأعلىلتغيير شكل المستطيل  ذلكو Explodeالتفجير أمر  سنستخدم ثم .7

الأمر  بتحديد العنصر ثم اخترقم  ذلكولعمل  ،مستقيمة لتسهل التعامل معها

Home>Modify>Explode. 

 وامرالأقائمة من الأمر  باختيار ذلكلنسخ الخط السفلي من المستطيل و Copyأمر  اختر .8

Home>Modify> Copy  بالضغط على الاختصار أوCO. 
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 .سم5 يأ م0.05 بمسافة المستطيل من السفلي الجزء انسخ( 32 -2شكل )

القيمة دخل أثم ليه إحرك المؤشر باتجاه المراد نسخ الخط  ذلكبعد  حدد الخط ثم  .9

0.05 . 

  Trim القطع أمر

 .تقاطع خطوطقرب أإلى  تقليم بعض الخطوط وتقصيرهاردت أحالة  فيالأمر  يستخدم هذا

 ذلكولعمل  ،نشائهاإعادة إوتفجيرها  بالإمكانف ةمعينتعديل على كتل  بإجراء ترغبفي حال و

 :تيةالآاتبع الخطوات 

 ما. أمري ألست في وسط  أنكمن  تأكدلل Escبالضغط على مفتاح  أابد .1

أو  Home>Modify>Trim وتجده ضمن قائمة   انقر على الرمز  من قائمة .2

 .TRبالاختصار 

سيطلب منك البرنامج تحديد  Trimأمر  مهم وهو عند اختيارأمر  إلى هنا نود التنويه .3

بالضغط مرتين  ذلكسؤال واللذا في هذا المستوى سنتجاوز  ،القطعأمر  مكان لتوقف

 .(2020ما قبل صدارات بالإتفعله  ) هذا ما على زر 

 .(33 -2)المشار لها في الشكل جزاء الأقم بالتخلص من  .4

 .Escبالضغط على زر  ذلكوالأمر  ننهي .5
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 .مباشرة عليها بالنقر ذلكو لها المشار جزاءالأ من تخلص( 33 -2شكل )

من خلال قائمة  ذلكو Toilet Seatلكامل المرحاض  Blockعمل خيرة الأالخطوة  .6

 .Bمن خلال الاختصار أو  Home>Block>Create    وامرالأ

 .ToiletSeatفلنسميه  Blockللـاسما  عطِأ .7

 تكون بمنتصف الخط العلوين أويفضل  Pickpointحدد نقطة المركز الخاصة به  .8

 .للمرحاض ليسهل التحكم به

 .PickObjectيقونة أمن خلال  ذلكله و  Blockحدد العنصر المراد عمل  .9

 .OKانقر موافق  .10

 

 .Blockبالـ الخاصة عداداتالإ دخلأ( 34 -2شكل )
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بعد  ذلكمشروع لديك وي ضافته لأإو أردتلديك مرحاض يمكن الوصول له متى صبح أن الآ

 dwg.حفظه بملف مستقل بصيغة 

 (35 -2شكل )النتيجة النهائية  .11

 
 .النهائية النتيجة( 35 -2شكل )

 Writeأمر  من خلال ذلكلبلوك بشكل مباشر واحفظ ملف  بالإمكان ملاحظة

Block  واختصارهW بعد تحديد العنصر واختيار مكان حفظ  ذلكو

 .الملف

 
 ذلكو Block كتلة يأ حفظ عند dwg ملف ضافةإب الخاصة النافذة( 36 -2شكل )

 . Wblockأمر  إدخالب
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 التخطيط للرسم

يزيد من كفاءة العمل وتوكاد الأفي هذا القسم سنتحدث عن التخطيط قبل الرسم على 

على البرنامج. فالبدء بالرسم بالخطة التي ستقوم بها للوصول للنتيجة النهائية سيساعدك لزيادة 

عنصر ي ولية لأأ اًتستخدم )كراسة رسم مربعات( لترسم خطوطن أالسرعة في العمل. هنا ينصح 

النتيجة إلى  لوصولوسرعة ل تالوقستوفر لك هذه الخطوة بعض  ،تود رسمه وكيفية الوصول له

 التي ستستخدمها للوصول للنتيجة المطلوبة.الأوامر بالنهائية فضلا عن الانشغال 

المعقدة من نقوش ورسومات مركبة يمكن الوصول لها بعد سلسلة من شكال ن الأأكما 

 الخطوط المساعدة.

 

 
 عن عبارة هي اليسار على المعقدة الزخرفة نأ نلاحظ( 37 -2شكل )

 تغيير يتم ثم ساسالأ هي فتكون عمالالأ امنه تبتدئ الدوائر من نوعين

هذه  ،النهائي للشكل للوصول تساعد التي الطبقات من لعدد الشكل

 . John Lockerbieالرسومات عمل المعماري 

 
 بشكل تفصيل( 38 -2شكل )

 كيف وتبين الهندسية للأشكال كبرأ

 الهندسي للشكل الوصول يمكن

 .البسيطة الخطوط من ءابتدا المعقد

 اًن لكل شكل معقد غير منتظم خطوطأ( 38 -2)و ( 37 -2)فنلاحظ من الشكل 

 عليها لتساعدك على الوصول للنتائج المبهرة. أساسية ينشأ

 .م1.20×0.70بمقاس  Bathtub مثال: رسم مسقط حوض استحمام )بانيو(

 الخطوات:

بعمل مستطيل من خلال  ذلكوبالأعلى بعمل مستطيل بالمقاس المطلوب الموضح  نبدأ .1

  Home>Draw> Rectangleادوات من قائمة بالضغط على شريط الأأو  RECمرلأا

 .(7,1.2.)القيمة التالية إدخال و
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إلى  بالأعلىلتغيير شكل المستطيل  ذلكو Explodeالتفجير أمر  سنستخدم ذلكبعد  .2

 .مرلأر ايابتحديد العنصر ثم اخت ذلكو ،معهاالتعامل سهل يلخطوط مستقيمة 

3. Home>Modify>Explode. 

 

 Offsetويسمى  اًجديد اًأمرنستخدم الآن 

 Offsetالنسخ بالتوازي  أمر

 Copyأمر  وهو يختلف عن المنسوخةللخطوط  متوازية طخطو لإنشاءاوفست يستخدم أمر  

اوفست يسمح لك بعدد معين  أمرعنصر تقريبا ولكن ي لأنسخ  بإجراءالنسخ يسمح لك  أمرف

 ,linesالخطوط المستقيمة ودائرة والخطوط المتصلة وقواس والأمثل الخطوط  نواع الخطوطأمن 

arcs, circles, ellipses, splines, and 2D polylines عنصر واحد في للا إتكرار اليمكن  لاو

 .ذلكالمرة الواحدة ل

 نقوم بالخطوات التالية:  Offsetولعمل 

ستظهر لك الرسالة  Oبالاختصار أو  Home>Modify>Offsetقائمة من الأمر  اختر .1

 التالي:

Specify offset distance or [Through/ Erase/ 
Layer] 

 .0.07سندخل القيمة  ،لها Offset عليك بتحديد المسافة المراد عمل اوفست :وتعني .2

ونختار العنصر المراد نسخ نسخة متوازية له ثم  لمؤشر الاختيار رة أالفسيتغير مؤشر  .3

 .سفلالأأو  للأعلىتحريك المؤشر بالاتجاه المراد النسخ له سواء 

 الشكل.خطين للداخل من كل الاتجاهات للمستطيل كما في خ سسنن .4
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  0,07 بمسافة مرتين ساسيالأ للخط Offset بعمل نقوم( 39 -2شكل )

 . بعد الانتهاء نضغط على مفتاح .5

سيتوجب ن الآ ،هذه الخطوط ستساعدك باختيار النقاط المساعدة للوصول للنتيجة النهائية

 أوامروسنستخدم  ،عليك استخدام الخطوط الداخلية لحوض الاستحمام لتصل للنتيجة النهائية

osnap ننشغل بالتصاق  لكيلا ةمعين أوامرسنحتاج لتحديد  ،لتحديد النقاط المرادة بكل سهولة

 سنتبع الخطوات التالية: ذلكبها. ولعمل  بلا نرغبنقاط رة أالف

إدخال بأو  المساعدةالأوامر من شريط   Object Snapمرلأيمن الأبالنقر بالزر  نبدأ .أ

 .OSأمر

 .Clear Allبالنقر على زر  ذلكنزيل جميع الخيارات و .ب

 .IntersectionوMidpointو Endpointخيارين من اليسار ول أنختار  .ج



 مبادئ الرسم بالحاسب

 

 رسمع 011

 

 
77 

 

 .بالصورة الموضحة الخيارات على والنقر Clear All على بالنقر علينا بالصورة كما( 40 -2شكل )

 .للاعتماد Okننقر  .د

النقاط التي تم اختيارها من النقاط  لأقربالسطح جاهزا للعمل. سيلتصق المؤشر  أصبحن الآ

الافتراضية عدادات الإهي عدادات الإهذه  واضحة الخطخر آبعلى الخط والنقاط  المتوسطة

 وما هتجاهل هذه الخطوات مع التقدم في التعامل مع البرنامج ورؤية أو  استبدال )بالإمكان

 .بشكل اسرع(نجاز الإعلى  كما يساعدمناسب وعمل 

 :الخطوات  

 المطلوبة،النتيجة إلى  الداخلية لتصلقواس الأالرسم الداخلية تعتمد على رسم مجموعة من  

 :فالخطوات لرسم هذه العناصر هي التالية

. Aانقر على أو  Home>Draw>Arcمن قائمة  Point Arc-3القوس أمر  انقر على .1

 .(41 -2)لهذا القوس انظر الشكل ضافية الإمن الخيارات  اهناك عددن أستجد 

من بتداءً االرسم من الشكل العلوي بناء على الخطوات المتبعة على الصورة المرفقة  أابد .2

 .(42 -2)نقطة التقاطعات العلوية كما في الشكل 
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 العمل يناسب ما منها راتخت قواسالأ من مجموعة هناك نأ ستجد الجانبية القائمة على النقر عند( 41 -2شكل )

 . Arc 3 Pointأمر  سنختار التمرين هذا في ،نجازهإ المراد
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 .بالشكل ةالتالي الخطوات طبق( 42 -2شكل )

والتي تشير  Xويسمح بظهور علامة  Intersectionأمر  سيتفعل لنا Osnapأمر  بتفعيل .3

 لها.وبداية القوس  1نقطة التقاطع كنقطة رقم اختيار إلى 
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 . Intersection( تداخل 43 -2شكل )

النقطة الثانية التي ستكون في منتصف الشكل بالخط المنسوخ إلى  بتحريك المؤشر .4

على نقطة المنتصف لهذا الخط المشار  أنكوالتي تعني ب ،ستظهر لنا علامة المثلثول الأ

 الصورة.كما في ليه إ

 

 . Midpoint( منتصف الخط  44 -2شكل )

 يكون بالجانب المناظر له. سالقو مرلأاختيار النقطة الثالثة  .5

 

 .قطة المقابلةنبال Intersectionتداخل  (45 -2شكل )

 مفتاح  لندخالأمر  لأنهاء( 42 -2)موضح بالشكل  وما هنتمم باقي الخطوط حسب  .6

 .مروسينتهي الأ

على لوحة  Tabبالضغط على مفتاح  Osnapالتنقل بين نقاط  بالإمكان ملاحظة

 المفاتيح.

  :من حوض الاستحماميسر الأبالجانب  نبدأن الآ

أمر  خرآعلى مفتاح مسافة لاستدعاء  الضغط بالإمكانأو  .خرىأ ةمر Arcأمر  رانخت .1

 استخدمته.
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اتبع الطرق أو  .دخالهاإنقطة تم خر آلتكون نقطة البداية هي من  ذلكو @ندخل الرمز  .2

 .ولالأالتي قمت بعملها مع القوس 

 .الثانيةلتكون النقطة وسط الأحدد منتصف الخط  .3

 :حدد نهاية الخط لتكون كما هي موضحة بالشكل التالي .4

 

 
 ( 46 -2شكل )

 .مرلننهي الأ نضغط  .5

 اًلو رسمنا بمنتصفه خطن أي أحوض الاستحمام هو عبارة عن شكل متناظر ن أبلو لاحظنا 

 .التناظر Mirrorأمر  التالي وهوالأمر  وهنا يمكننا الاستفادة من ،للاحظنا تطابقه التام

 Mirrorالتناظر 

من العناصر  اًكثيرن إحيث  ،وتوكادالأالمهمة في برنامج الأوامر التناظر من أمر  يعتبر

بل بالقيام بنصف الجهد خرى أ ةمرتعيد رسم العناصر ن أليس عليك و ،المعمارية تكون متناظرة

ن إببعض التفاصيل  أكثرمما يتيح لك فرصة للعمل  ،ونسخه بالتناظر لتكتمل صورة المشروع

 لزم.

 
 عنصر على التركيز يمكننا كيف   Villa Capra La Rotonda لمبنى والقطاع نلاحظ الواجهة( 47 -2شكل )

مصدر الصورة موقع  -لعملها الوقت من الكثير توفر مما للمشروع الكاملة الصورةإلى  للوصول واحد

https://archeyes.com/ 



 مبادئ الرسم بالحاسب

 

 رسمع 011

 

 
82 

 
 Villa Rotonda  لمبنى الظلال بعض ضافةإ مع القبة لشكل خرآ اًمقترح تبين لمشروع خرىأ واجهة( 48 -2شكل )

by Andrea Palladio . 

 :التاليةالاستحمام يجب عليك اتباع الخطوات  ضحوعلى  ذلكولتطبيق 

 ما. أمري ألست في وسط  أنكمن  تأكدلل Escبالضغط على مفتاح  أبدا .1

أو  Home>Modify>Mirrorقائمة وتجده ضمن  قائمة انقر على الرمزالمن  .2

 .miبالاختصار 

 .العنصر المراد نسخه عليك تحديدحيث يتوجب  إلى  رةأستتغير شارة الف .3

استخدم نقاط التنصيف  ،سيكون بمنتصف حوض الاستحمامي ذوالارسم خط التناظر  .4

 .المثلثة

 :التاليةستظهر لك الرسالة  .5

Erase source objects? [Yes/No] <No:> 

 الجديد؟ لا بقاء إوهل يتم مسح العنصر المحدد 

 فنكبس  Noالافتراضية  فالإجابةالجانبين  نحافظ على القوس بكلان أنريد 

 .للاستمرار

 .بالكبس على المفتاحالأمر  ننهي .6

 .(49 -2شكل ) سننتهي بهذه النتيجة
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 . Mirror التناظرأمر  تطبيق بعد النهائية النتيجة( 49 -2شكل )

 Erasingحذف الخطوط المساعدة 

سيتوجب عليك حذف جميع الخطوط المساعدة التي رسمتها لتساعدك على الوصول للنتيجة 

من تحديد العناصر التي تريد حذفها قبل  تأكدفي هذه الخطوة ست الاستحمام،النهائية لحوض 

 الحذف.أمر  اختيار

 :الخطوات

 بالخطأ اًمن الخطوط التي تريد حذفها )في حال اخترت خط ةحداختر كل خط على  .1

تظهر ن أعلى لوحة المفاتيح والنقر عليه بعد  Shiftبالتعليق على زر  ذلكيمكنك التراجع و

 .(جانب مؤشر الفأرة –علامة 

من قائمة   زاختر الرمالخاص بحوض الاستحمام.  الإطارعلى بقاء الإمن  تأكد .2

Home>Modify>Erase  باستخدام الاختصار أوe ، كما يمكنك الكبس على زر

Delete  .على لوحة المفاتيح 

 .النتيجة النهائية .3
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 .المساعدة الخطوط حذف بعد النهائية النتيجة( 50 -2شكل )

 ضافة لمسات نهائية للمشروعإ

خطوط  بإضافة ذلككيف يمكن عملها ورسوم معقدة وتعلمنا نشاء إالتقدم في  أحرزناقد 

زال لدينا  ولكن ما ،جلهاأمن  توهمية مساعدة يتم مسحها فور انتهاء الوظيفة التي رسم

زاوية إلى  . فنحن بحاجةأكثرالحادة التي يجب علينا معالجتها لتعطي صورة واقعية  الزاوية

و  Filletأمر  همة وهوالمالأوامر  أحدالسطح. وهنا سنتعرف على إلى  مدورة لتعطي نعومة

Chamfer. 

 Fillet الزاويةجمع 

لهذا  الرئيسةالوظيفة  تالمقوسة ولكن هذه ليس الزاويةالذي سنستخدمه لرسم الأمر  هذا

متقاطعتين ليوصلهم بزاوية. أو  خطين غير موصولين ببعضي أيجمع بين الأمر  . هذامرالأ

 .(51 -2شكل )التعديل عليها لتصبح مدورة كما في جراء إ بالإمكانهذه الزاوية 

من خلال أو  Home>Modify>Filletتجده ضمن قائمة   Filletمرلأوللوصول 

 .Fالاختصار 

 

 Chamferجمع الزاوية بشطفة 

 ولكن يشطف النهاية. وهذا Filletبعمل نفس وظيفة  ميقوالأمر  وهذا

 .Filletأمر  يكون ضمن القائمة المنسدلة منالأمر 
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 .الزاوية هذه تعديل يمكن حيث بزاوية توصيلهما يمكن نامتوازي ناخط موضح الشكل في كما( 51 -2شكل )

  :الخطوات

 Fبالاختصار أو  Home>Modify>Fillet   وامرالأاختر من القائمة  .1

أو  لاختيار الخطين المراد تعديل الزاوية لهما ذلكو للشكل رة أالفسيتغير مؤشر  .2

 توصيلهما لبعض.

 Command الـوستظهر لك هذه الرسالة بشريط  .3

Select first object or 
[Undo/Polyline/Radius/Trim/Multiple] 

وهذه تمثل  0,10الزاوية الجديدة إلى  0لنغير الزاوية الافتراضية وهي  Rسنكتب  .4

 نصف قطر القوس.

 الخطين المتقابلين في الزاوية العلوية اليمنى.نخار  .5

سنضغط على مفتاح  –اختصارا  –خرى أ ةمرالأمر  باستدعاء ذلكنعيد الخطوات و .6

 تم استخدامه.أمر  خرآعلى لوحة المفاتيح لاستدعاء  Spaceمسافة 

  

 .م0.10قطر بنصف Fillet عمل بعد النهائية النتيجة( 52 -2شكل )
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وسنطبق هنا فقط   سيتطلب عليك تحديد المسافة من كل ضلع Chamferأمر  في حال استخدام

 للتجربة.

  الخطوات

 .Chaبالاختصار أو  Home>Modify> Chamfer   وامرالأاختر من القائمة  .1

 شطفة بينهما.ضافة إلاختيار الخطين المراد  ذلكو للشكل رة أالفسيتغير مؤشر  .2

 .Commandوستظهر لك هذه الرسالة بشريط الـ .3

 
(TRIM mode) Current chamfer Dist1 = 0.00, 
Dist2 = 0.00 

 )المسافة تمثل البعد من الخط الثانيأو  ولستظهر لك قيم بالمسافة الحالية لكل من الخط الأ

 .عن الزاوية القائمة

Select first line or 
[Undo/Polyline/Distance/Angle/Trim/mEthod/Mul
tiple 

 Dحرف إدخال ب ذلكو Distanceالتوصيل والذي سنختاره هو المسافة سلوب أحدد 

 
Specify first chamfer distance <0.00>: .1 

 0.10دخلنا أوهنا ولا أره اللخط الذي ستختالأولى  سيطلب منك تحديد المسافة

Specify second chamfer distance <0.10>: .1 

 0.10دخلنا أره ثانيا وهنا اثم سيطلب منك تحديد المسافة الثانية للخط الذي ستخت

درجة لتساوي 45الخط يمثل زاوية ن والآ. دخلتهاأوستحصل على شطفة حسب القيم التي 

 القيمتين.

 التعديل بالمقاساتوإجراء تعدد الخيارات 

لدينا عدد مقاسات من العنصر نفسه فعلى سبيل المثال حوض الاستحمام  نما يكوكثير 

تعديلات على جراء إلذا يتوجب علينا  ،مقاسات لنفس الحوض بنفس التصميم 3لدينا  بالأسواق
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 0,70×1,20رسمناه كان بطول  فعلى سبيل المثال ما ،المقاسات للوصول للمقاسات المطلوبة

 :3هي  بالأسواقوالخيارات 

 0.70×1.20 .أ

 0.70×1.50 .ب

 0.70×1.70 .ج

اختصاره أو  Stretchأمر  جديد وهوأمر  فنريد عمل تعديل على الحوض نفسه. هنا سنتعرف على

S . 

 . Copyبعمل  ذلكنسخ للبانيو نفسه و 3ولكن قبل الشروع بالتعديل علينا نسخ 

 :نسخ العنصر بعدد المقاسات 

من خلال أو  Home>Modify>Copy  من خلال القائمة ذلكانسخ العنصر و .1

 .COالاختصار 

تحريك المؤشر بالاتجاه المراد  –هنا لدينا حوض البانيو  –حدد العنصر المراد نسخه  .2

ليتحرك باستقامة للجهة  F8أمر  الجهة اليسرى وسنفعلإلى  النسخ له فسنحرك المؤشر

 لتتداخ لالكي اليسرى ثم ندخل القيم بحيث نترك مسافة بسيطة بين كل عنصر

وندخل الأولى  م للنسخة1سندخل  إذاً 0,70فعلى سبيل المثال عرض البانيو هو شكال الأ

النسخ كان من مصدر واحد ن لأضاعفنا العدد ننا أونلاحظ هنا  ،م للنسخة الثانية2

 فستتغير طريقة النسخ. اًالنسخ جرافيكي كانولكن لو  ،بقيمة مرجعية واحدة

 .مرالأ لإنهاء Escنكبس على زر  .3

 .Stretchأمر  نسخ من البانيو سنقوم بتعديل المقاسات من خلال 3لدينا  أصبح

 Stretchالشد  أمر

ي واحد وسنطبقه هنا على البانيو لنتعرف إحداثي عنصر باتجاه ألتكبير الأمر  ويستخدم هذا

 على طريقة الاستخدام.
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 :الخطوات

 . Sالاختصار  أمربأو  Home>Modify>Stretchمن قائمة التعديل الأمر  اختر .1

 ذلكحيث يمكن تحديد الخطوط المرادة ولكن ك لتكون رة أالفستتغير شارة  .2

 اًهناك تحديدن أبكما تم شرحه سابقا  المجمل،استخدام خاصية التحديد  بالإمكان

اللون  اذوالتحديد  ،استخدامه في هذا التمرين بلا يجوهو الذي زرق الأيظهر فيه اللون 

الشكل  دلا تحد أنكولكن هناك نقطة مهمة يجب التنويه لها بفضل الأوهو خضر الأ

 .(53 -2) الشكل بالكامل بل العناصر التي ستشدها. انظر

 

 .الجزئين في ينيددالتح طريقة بين اًفرق هناك نأ نلاحظ( 53 -2شكل )

فرق ضف أونقطة ي أبعد التحديد سيتوجب عليك تحديد نقطة لزيادة الحجم حدد  .3

 كمسافة. 0.30سندخل قيمة  إذاً  1.20-1.50=0.30لدينا حوض بمسافة  ،الزيادة

 .مرالأنهاء إودخال للإ ذلكو اتجاه الزيادة ثم إلى  حرك المؤشر .4

 

كما هو موضح شكال ألدينا ثلاثة يصبح و 1.70نكرر العملية للشكل الثالث ليصبح 

 .(54 -2)بالشكل 
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من قياس الخطوط وهذه البيانات خاصة  تأكداستخدام المسطرة لل بالإمكان ملاحظة

وللوصول لها من  كبيانات،تدخل  القياس فقط ولاثناء ألمستخدم البرنامج 

 Home>Utilities>Measure   وامرالأقائمة 

 
  Commandالـستظهر لنا هذه الرسالة على شريط 

Enter an option 
[Distance/Radius/Angle/ARea/Volume/Qu
ick/Mode/eXit] 

من  فيبدأيطلب منك البرنامج تحديد نوع القياس الذي تريد استخدامه 

 المساحة/الحجم /يةاوالز/قطارالأالمسافة/

تحديد  dإدخال علينا  ذلكلفي مثالنا الحالي سنستخدم المسافة المباشرة 

 المسافة 

 تطلب منك اختيار نقطة البداية لقياس المسافة خرى أستظهر لنا رسالة 

Specify first point: 

 نقطة الثانية ال

Specify second point or [Multiple points:] 

 يات كما في الشكل إحداثوستظهر لك الرسالة القيمة على شكل 

 
الحديثة للبرنامج تظهر لك خيارات سريعة لتعرفك بالمقاسات صدارات الإفي 

 .بمجرد تمرير المؤشر عليها
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 مؤشر تحريك بمجرد والمقاسات بعادالأ لنا توضح وهمية خطوط ظهور نلاحظ( 54 -2شكل )

 .العنصر على

 

 .المقاسات تعديل بعد النهائية النتيجة (55 -2شكل )

المقاسات إدخال مع ة حدلكل عنصر على  Blockللشكل للتمرين نقوم بعمل  كختام

 حسب الخطوات التالية: ذلكوالبيانات عليه و

 .Blockتحديد الحوض المراد عمل له كتلة  .1

 .B حرف Commandفي شريك الـإدخال بقم  .2

 .Bathtub 70x120cmللكتلة مثلا  اًاسم أعطِ .3

 .الخارجية واياالززاوية من ي أوحدد  Pickpointانقر على رمز  .4

 .Ok انقر .5

 الاستحمام.حواض أمقاسات من  ةنكرر العملية مع كل عنصر ليصبح لدينا ثلاث
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 م0.46×0.71بمقاس  Sinkمثال: رسم مسقط حوض غسيل 

 خطوات العمل:

 اهذوذلك بعمل مستطيل ويمثل  بالأعلىبعمل مستطيل بالمقاس المطلوب الموضح  نبدأ .1

من دوات الأبالضغط على شريط أو  RECمرلأومن خلال ا العلوي،المستطيل السطح 

  ، Home>Draw> Rectangleقائمة ال

 Command الـفي شريك تية الآستظهر لنا الرسالة  .2

Specify first corner point or 
[Chamfer/Elevation/Fillet/Thickness/Width] 

 .للمستطيلالأولى  بتحديد النقطةقم 

القيمة إدخال للمستطيل ثم الأولى  على سطح العمل لتحديد النقطةيسر الأ ربالنقر بالزقم  .3

 . (71.,46.)التالية 

 Zنضغط على  ربالسط ةلتوضيح الشكل كاملا لكل العناصر المرسوم ملاحظة

 ما تمالخطوة اختيارية في حال  ههذ ،رسمه ما تملنا كل ظهر يوس Eثم 

كما يمكن الضغط مرتين على  جدا،كبيرا أو  رسمه كان صغيرا جدا

 .مرلتقوم بنفس الأرة أالفعجلة 

 

 . Escبالكبس على الأمر  ننهي .4

ولكن قبل البدء  اًبيضاوي نحن بحاجة لرسم الحوض نفسه والذي سيكون شكلًان الآ

كما هو  Midpointأمر  ونفعل منه Osnapعيل خيار فبرسم الشكل البيضاوي يجب علينا ت

 . وقد تم شرح كيفية الوصول لهذه النافذة. (56 -2) موضح بالشكل
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 . Midpoint الخيار حدد( 56 -2شكل )

  :الخطوات

ترسم سيتوجب  ماحين هنأبنود التنويه  Y=0.30و  X= 0.40عمل الشكل البيضاوي بقطرين 

 نصف القطر. إدخال عليك 

 .وللوصول له سنقوم برسم الشكل البيضاوي  ذلكبعد  .1

Home>Draw> Ellipse   بالاختصار أوEL  اقطار نصاف أإدخال  دلا نري، ولكن

قم بالنقر على القائمة المنسدلة  ذلكفللقيام ب ،ندخل القطرين بشكل مباشرن أبل نريد 

 .نالآسنستخدمه  يالذالأمر  وهو Axis, End واخترالأمر  من

 بالنقرأو  Osnapالأمر  بتفعيل ذلكنحدد نقطة البداية للشكل البيضاوي ون أنريد ن الآ .2

 .Midpointومن ثم تختار  Shift + Right Clickعلى 

 Command الـستظهر هذه الرسالة بقائمة 

Specify axis endpoint of ellipse or 
[Arc/Center] 

للشكل البيضاوي والذي سيكون سي أالرلبداية القطر الأولى  تحديد النقطةوتعني 

 م.0.15سيكونخر الآم والقطر 0.40بقطر 

على منتصف الشكل رة أالفبالنقر مباشرة على الشكل بل مرر  ملا تقأب وتأكد

 .(57 -2)المستطيل كما في الشكل 



 مبادئ الرسم بالحاسب

 

 رسمع 011

 

 
93 

 
 .سفلللأ المؤشر نزلأو شيء يأ على الضغط دون Xالـ يحداثالإ بمنتصف رةأالف مرر( 57 -2شكل )

سنلاحظ ظهور خطين  (58 -2) الشكلكما في  Yالـ يحداثبالإثم قم بتكرار العملية 

د مركز المستطيل في حال قمت برسم خطوط مساعدة ولكن يلتحدخضر الأمتقطعين باللون 

 فقط نعتمد على هذه الخطوط الوهمية المساعدة. ،لرسملهنا لسنا بحاجة 

 

 .متقطع بشكل خضرلأا باللون سيأر خط ظهور لاحظ ( 58 -2شكل )
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 .فقيأ خط ظهور سنلاحظ العملية تكرار عند( 59 -2شكل )

 

 .امعليه النقر يمكنك+  بشكل نامتقاطع ناخط لدينا سينتج خرالآ للجانب العملية تكرار عند( 60 -2شكل )

إدخال لليمين ورة أالفلذا سنقوم بالنقر بمنتصف الشكل وتحريك  0.40قطر الحوض هو  .3

 .0.2القيمة 

 ..15والتي ستكون سية أالرلندخل القيمة  للأعلىنحرك المؤشر  .4

 .أمر  على وسننتهي من هذه الخطوات بالضغط .5
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  Blockعمل كتلة 

المقاسات إدخال مع  ةحدى لكل عنصر عل Blockللشكل للتمرين نقوم بعمل  كختام

 حسب الخطوات التالية: ذلكو ،والبيانات عليه

 .Blockتحديد الحوض المراد عمل له كتلة  .1

 .Bحرف   Commandفي شريك الـإدخال بقم  .2

 .Sink71x46cmللكتلة مثلا  اًاسمأعط  .3

 .الخارجية يااالزوزاوية من ي أوحدد  Pickpointانقر على رمز  .4

 .Okانقر  .5

 لحوض الغسيل بالمقاس الموضح. Blockلدينا كتلة صبح أن والآ

 حفظ العمل 

على الدوام  ذلكبقيامك ب تأكددقيقة ف15-10المهمة هو حفظ العمل كل مور الأمن 

 وباستمرار.

 .Ctrl+Sولحفظ العمل 

 مثال: عمل دورة مياه 

خلال التمارين السابقة تعلمنا كيفية طرق الرسم والتعديل على الرسومات وكيف تتعامل 

يتمثل بدورة مياه تحتوي  اًواحد اًمعها. في هذا التمرين سنجمع جميع الرسومات لتكون مشروع

 وبانيو. ،فرنجيإمرحاض  ،على جميع العناصر من حوض غسيل

م والتي تمثل المسافة بين المحاور مع عمل جدران 2.20×1.90ه بمقاس سنقوم برسم دورة ميا

 .سم20بسماكة 

لها  Blocksقمنا بعمل  لأننا ذلكحذف كل العناصر التي تم رسمها و بإمكانناقبل العمل 

م ئهذه القوان أبكما نود التنويه . Home>Block>Insertحيث يمكن استدعائها من قائمة 

لن تجدها عند فتح مشروع جديد. لذا احفظ نسخة خاصة  أنكي أموجودة فقط في هذا الملف 

 خرى. ة أبالبلوكات لتتمكن من فتحها مر
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  :حسب الخطوات التي تم شرحها مسبقا ذلكبرسم مستطيل بالمساحة المطلوبة و نبدأفل

هذا المستطيل سيمثل ن إحيث  بالأعلىبعمل مستطيل بالمقاس المطلوب الموضح  نبدأ .1

مرلأومن خلال ا العلوي،وذلك بعمل مستطيل ويمثل هذه المستطيل السطح  المحاور،

 REC  من قائمةدوات الأبالضغط على شريط أو 

 Home>Draw> Rectangle.  

 Command الـفي شريك تية الآستظهر لنا الرسالة  .2

Specify first corner point or [Chamfer/Elevation 
/Fillet/Thickness/Width] 

 للمستطيلالأولى  قم بتحديد النقطة

القيمة إدخال للمستطيل ثم الأولى  على سطح العمل لتحديد النقطةيسر الأ ربالنقر بالزقم  .3

 . (1.90,2.20)التالية 

4. Offset   نقوم بالخطوات التالية:  

ستظهر لك  Oبالاختصار أو  Home>Modify>Offsetمن قائمة الأمر  اختر .أ

 الرسالة التالي:

Specify offset distance or[Through/Erase/Layer] 

قد ذكر بالسؤال ن أبنود التنبيه  ،وتعني عليك بتحديد المسافة المراد عمل اوفست لها .ب

 السنتيمترنرسم بالمتر فعلينا تحويل قيمة ننا إحيث  ،سم20بان سماكة الجدار هي 

إذا ،100بالتقسيم على  ذلكمتر وإلى 
20

100
 .م  0.20= 

للداخل  ةنسخثم نحدد الخط وننسخ منه  رة لمؤشر الاختيار أسيتغير مؤشر الف .ج

فندخل قيمة  ،الجدار(المحاور تكون بمنتصف ن أوللخارج بنصف المسافة )كون 

0.1 ثم نكبس للداخل مرة وللخارج مرة. ونحدد المحور 

 .(61 -2)مستطيلات بهذا الشكل  ةلدينا ثلاثخ سسنن .د
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 المقاسات حسب الداخلية المسافة كونت نأ المهم، بينهما م0.10 بمسافة مستطيلات ةثلاث لدينا صبحأ( 61 -2شكل )

 .بالشكل موضح هو كما م2.10×1.80 بمقاس سيكون مستطيل صغرأ نأ يأ المطلوبة

وسط الأالخط ن إفلنترجم هذه الخطوط كما عليك فهم ما الذي تعنيه الخطوط حيث 

سم كما 20تكون ن أسماكة الجدار والتي يجب  نيمثل المحاور والخطين الخارجيين يمثلا

 طلب منا في السؤال.

م من الخط الخارجي 2بمسافة  Offsetنقوم بعمل ن أسنعيد العملية ولكن هذه المرة نريد 

 .(62 -2)لنا كما في الشكلليصبح 
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 .له المحاور خطوط مد من نتهيناا ما متى سنحذفه تمؤق خط هو الخارجي الخط هذا( 62 -2شكل )

 Explode نقوم بتفجير ذلك ولعمل Rectangle الـإلغاء الشكل 

وتجعلك تتعامل مع الشكل بشكل  Polylineعبارة عن حلقة متصلة تسمى  المستطيل هو

ويمكننا سهل أكلي ولكن نحن بحاجة لفصل هذه الخطوط ليتسنى لنا التعامل معها بشكل 

 عمل محاور بالشكل المطلوب دون معوقات.

 ما. أمري ألست في وسط  أنكمن  تأكدلل Escبالضغط على مفتاح  أابد .1

 .Home>Modify>Explodeوتجده ضمن قائمة   انقر على الرمز  من قائمة .2

 .حيث يمكنك تحديد العنصر المراد تفجيره إلى  سيتغير المؤشر ذلكبعد  .3

 .للإدخالمسافة أو  اضغط  .4

 .تمت عملية التفجير .5

 Axesعمل المحاور 

عن طريق  Polyline الـتم فك ن أها بعد ارفع المحاور للخطوط الوهمية التي عملن بإمكاننا

النقر على الخط وسيتم تحديده وستظهر الثلاث نقاط )في  بالإمكانالتفجير. ولرفع الخطوط ف

 بالإمكانوعندها حمر الأنهاية( الخط وعند النقر على واحدة منهم ستتغير للون  وسط، بداية،

 مدها بشكل يدوي.
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 قيمة خالدكإ لها مباشر بشكل القيمةإدخال بأو  المطلوبة للنقاط والسحب النقر طريق عن التحريك( 63 -2شكل )

 .م2,10

مضيعة كون تسحيان غلب الأأولكن في حيان الأوهذه الطريقة ربما تكون عملية في بعض 

 للوقت تكرار العملية بشكل كبير.

 Extendأو  الاستمرار أمر

له ضمن القائمة المنسدلة.  المجاورةالأوامر من نه إحيث  Trimأمر  شقيقالأمر  يعتبر هذا

 .EXالاختصار وهو إدخال  بالإمكانو

 
 

 :الخطوات

 ما. أمري ألست في وسط  أنكمن  تأكدلل Escبالضغط على مفتاح  أابد .1

 Home>Modify>Extendقائمة وتجده ضمن  انقر على الرمز  من قائمة .2

 .EXبالاختصار أو 

 . Extendأمر  مهم وهو عند اختيارأمر  إلى هنا نود التنويه .3
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Select object to extend or shift-select to trim 
or[Boundary edges/Crossing/mOde/Project:] 

 مامهأط مقابل له ليتوقف خيمكن تحديد أو  حدد العنصر الذي تود استمراره

ستحتاج للنقر مرتين على الخط ليتجاوز  Boundary edgesأمر  ن لم تخترإسنلاحظ هنا 

 للنقر مرتين.حتاج ته سمماأيتوقف ن أفي حين لو لم تقم بتحديد العنصر الذي يجب المبنى 

 رسمناه.ي ذالالمؤقت  الإطارونحدد  Boundary edgesأمر  لنختار Bننقر على الحرف  .4

كما في مثالنا طار الإخطوط المحاور )مامها أتقف ن أقم بالنقر على الخطوط التي تريد  .5

 .الحالي( ثم انقر 

 .على الخطوط التي تمثل المحاور لتستمرنقر بالقم  .6

 .كرر العملية على جميع الخطوط التي تمثل المحاور .7

 .Escبالضغط على مفتاح الأمر  قم بإنهاء .8

 

 .الوقت من الكثير يوفر وهذا Boundary edgesأمر  اختيار عند الفرق نلاحظ( 64 -2شكل )

 

وعند البدء باختيار الخطوط التي ستمددها   Extendأمر  استخدامعند  ملاحظة

إلى  Extendمن الأمر  وسيغير Shift+Clickالضغط على مفتاح  بإمكانك

Trim فأعلى 2020صدار إفعال من الأمر  هذا. 
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 .مرلم يكن هناك خط يوقف استمرار الخط فلن يعمل هذا الأن إ ملاحظة

 

 

 
 .النهائية النتيجة( 65 -2شكل )

 Circleالدائرة أمر  عن طريق ذلكورسم خطوط المحاور وطار الإسيتوجب علينا حذف ن الآ

 .م0.80=قطر الدائرةن أو

 جميعها ليسهل لنا العمل. Osnapالـ  أوامرقبل البدء سنفعل 

 هنالك عدد من الطرق لرسم الدائرة سنستعرض اثنتين منهما:

 :ولىالأالطريقة 

 .Moveالتحريك  أمرو Circleالدائرة أمر  ين وهماأمرنستخدم ن أوالتي سنحتاج فيها 

 )سنرسم Cبالاختصار أو  Home>Draw>Circle   وامرالأالدائرة من قائمة أمر  رانخت .1

 .(نيمالأالمحور س أردائرة على 

ندخل قيمة نصف القطر للدائرة  .2
0.80

2
 .م 0.40=

 .Moveالتحريك أمر  عن طريق ذلكالدائرة ونقوم بتحريك 
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 Mبالاختصار أو  Home>Draw>Move وامرالأالتحريك من قائمة أمر  نختار .3

 Osnapالـ أوامرهذا المكان الذي سيسهل عليك تفعيل ن إنحدد مكان القبض حيث  .4

 Osnapالـأمر  ليتفاعل للأعلىمعه فسنحدد الطرف السفلي من الدائرة ثم نحرك المؤشر 

 .معها

 .(66 -2)ليلتصق بنهاية الخط كما في الشكل  للأعلىنحرك المؤشر  .5

 
 وضع المراد بالاتجاه شرؤالم نحرك ثم ومن التحريك مركز لتكون للدائرة السفلي الطرف نحدد( 66 -2شكل )

 .المحور سأر وهو فيه الدائرة

 الطريقة الثانية:

الدائرة لرسم الدائرة وهي الطريقة المثلى في هذا  أطرافمن  اًطرفتحدد ن أسيتوجب عليك 

 :المثال

 )سنرسم Cبالاختصار أو  Home>Draw>Circle وامرالأالدائرة من قائمة أمر  رانخت .1

 .(نيمالأدائرة على راس المحور 

والتي تقصد سنرسم الدائرة باستخدام  2Pأمر  ستظهر لنا الرسالة التالية وسندخل .2

 نقطتين

Command: _circle 
Specify center point for circle or [3P/2P/Ttr (tan 
tan radius)]: 2p 

 .0,80وندخل قيمة  للأعلىالمحور ثم نحرك المؤشر س أرسننقر على 

Specify second end point of circle's diameter: .8 

بين  خيار سرعأو أسهلرسم الدائرة بدون الحاجة لتحريكها وهذا  تم هنأنلاحظ 

ن إالقيمة اختلفت حيث ن أيضا أولكن نلاحظ  ،اما بينهمالطريقتين هو السرعة في
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قد  الثانيةولكن بالطريقة  0.40نصف القطر وهو إدخال توجب علينا الأولى  الطريقة

 .(0.80)القطر بالكامل وكان دخلنا أ

 

 .المحاور )دوائر المحاور( سرؤوالذي تم رسمه لتحديد مواقع  الإطارعلينا حذف ن الآ

 

 

 .المحاور دوائر ضافةإ بعد النهائية النتيجة (67 -2شكل )

 Blocks الـ إدراج

فرش  لإضافةعدد من الكتل التي يمكن استخدامها  لإنجازخلال هذا الفصل قد عملنا 

 معماري لدورة المياه والمتواجدة داخل ملف البرنامج. 

 
 

  :الخطوات

 .Home>Block>Insertمن قائمة  .1
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 .يسرالأعليه بالزر نقر اوالمناسب لك  Blockالـاختر  .2

 .يسرلأابالزر ر قوانتحدد المكان الذي تريد وضعه فيه  .3

لضبط الموقع كما  Moveالتحريك أداة مكان ثم استخدام ي أوضعه في  بالإمكان .4

 .(68 -2) بالشكل

 

 . Moveأداة  باستخدام الموقع مع مهؤتوا عدم حال في Blockالـ موقع ضبط عادةإ( 68 -2شكل )

 
 . Midpointالـ تفعيل من ونتأكد Osnapالـأمر  تفعل( 69 -2شكل )



 مبادئ الرسم بالحاسب

 

 رسمع 011

 

 
105 

 بالإمكانفي حال وجود مكتبة البلوكات الخاصة بك في موقع غير الملف الذي تعمل عليه ف

 حسب الخطوات التالية: ذلكالمكتبة و بإضافةالاستدعاء 

 يسرالأننقر عليها بالزر  …Blocks from Librariesالقائمة خر آسنجد  Insertمن قائمة 

 .(70 -2) كما في الشكل

 

 . Blocks from Libraries على بالنقر قم( 70 -2شكل )

مكتبتك إلى  لتضاف Blockالـيحتوي الملف على مكتبة من ن أقم باختيار موقع الملف ويجب 

  .في داخل المشروع

 .اختر البلوك الجديد وقم بالنقر عليه كما تم الشرح سابقا .1

 
 .مسبقا بعمله قمنا الذي D1 الرمز يذ الباب ضافةإ تتم هنأب نلاحظ( 71 -2شكل )
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عملها وهي بفتح مشروعين يحتويان على مكتبتين مختلفتين ونسخ  بالإمكانخرى أطريقة 

والذهاب للمشروع الثاني والكبس  Ctrl+Cالعناصر بعد تحديدها ومن ثم الكبس على 

 .وتعتبر هذه الطريقة سريعة جدا  Ctrl+Vعلى 

 .(72 -2)نه بالاتجاه الصحيح !؟ انظر الشكل أب ولا يبدضافة الباب ولكن إ تتم

 
 تعديلإلى  بحاجة ولكن الباب ضافةإ تتم( 72 -2شكل )

 Rotateالدوران  أمر

جزاء والعناصر كما لدينا هذه المشكلة هنا كما في الشكل نحتاج لعمل دوران لبعض الأ

 ليكون بموقعه المناسب.حيث علينا تغيير اتجاه الباب  (72 -2)

 :الخطوات

  Home>Modify>Rotate من قائمة ذلكو مرلأاختر ا .1

 .ROبالاختصار  (او)

 . شكل مربعإلى  سيتغير المؤشر .2



 مبادئ الرسم بالحاسب

 

 رسمع 011

 

 
107 

 .حدد العنصر )وهو الباب في مثالنا هذا( ثم  .3

 ستظهر لك هذه الرسالة

 Specify base point  

 (73 -2)باتجاه الدوران كما في الشكل رة أالفويقصد بها حدد مركز الدوران ثم حرك 

 ستظهر لك هذه الرسالة

Specify rotation angle or [Copy/Reference]  

 .(74 -2)انظر الشكل  °90زاوية الدوران دخل أ

 

 بالنقر الدوران مركز حدد( 73 -2شكل )

 .عليه

 

 قيمة دخلأو الدوران اهتجا نحو المؤشر حرك( 74 -2شكل )

 .المثال هذا في 90° فهي الدوران

م 1,20الباب بعرضن أولكن نجد  98-2تم تعديل الباب كما في الشكل  هنأبنلاحظ 

 لكونه باب دورة مياه لذا نحن بحاجة لتعديله وهنا سنتعرف على ةنسب جداً اًوهذا يعتبر كبير

 .Scaleأمر  جديد وهوأمر 

 Scaleتغيير الحجم  أمر

 ةشياء نسبالأومقاسات حجام أضبط عادة إالذي عن طريقه يمكن الأمر  سكيل وهو أمر

ي أحجم ن أي أيقوم بالتصغير والتكبير بنسبة كسرية الأمر  هذان إمع استخدامها حيث 

فيصبح الباب الذي  2قيمة إدخال بمضاعفة الحجم فتقوم  أردتإذا ولكن ،  1عنصر يعتبر 

 0.50النصف فندخل قيمة إلى  نقلل حجمهن أ اردنأإذا ولكن ،  2.40إلى  1.20لدينا بعرض 
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لنتمكن  بعادنتعرف على طريقة حساب الأن ألذا يجب  0.60إلى  1.20وسيصبح عرض الباب من 

 من التحكم بالحجم بالطريقة الصحيحة.

 فتكون المعادلة كالتالي: 0.90حجم إلى  1,20نغير حجم الباب من حجم ن أنريد 

0.75= 
0.90

1.20
=

 المسافةالجديدة

 البعد الحالي
 

 
 .سم90 ليكون لتصغيره بحاجة فنحن جدا كبير الباب حجمأن  نلاحظ( 75 -2شكل )

 :الخطوات

من خلال الاختصار أو  Home>Modify>Scaleوامرالأمن قائمة  مراختر الأ .1

SCA. 

 .شكل مربعإلى  سيتغير المؤشر .2

 .حدد العنصر )وهو الباب في مثالنا هذا( ثم  .3

 ستظهر لك هذه الرسالة .4

Specify base point  

يكون مركز الباب مركز مفصل ن أويقصد بها حدد مركز التكبير ويفضل 

 .الحركة

 ستظهر لك هذه الرسالة

Specify scale factor or [Copy/Reference]:  

 . 0.75الناتج الكسري الجديد والذي تم حسابه وكان دخل أويقصد بها 
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  فلنقم ببعض التعديلات البسيطة

ه فتح الباب االتناظر وعكس اتجأمر  باب دورة المياه يفتح للداخل فيجب علينا استخدام

 .Mirrorأمر  باستخدام

 
 لكيلا المرة هذه المصدر حذف علينا ذلكك المحور خط على مطابقا ليكون التناظر خط تحديد( 76 -2شكل )

 .متعاكسين باتجاهين نسختين لدينا تصبح

بقدر نصف بلوكة فيجب علينا التحريك ي أسم 20يبتعد الباب عن الجدار بمسافة ن أيجب 

 .Moveأمر  باستخدام ذلكم و 0.20بمقدار للأعلى 

 
 طبقا وهذا ،ذلك خلاف يكون لاأو بلوكة نصفأو  بلوكة بمقدار الجدار عن الباب بعادإ علينا( 77 -2شكل )

 .البلوك عمالأ تنفيذ ثناءأ فنية مورلأ
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 .(78 -2)مستقيم كما في الشكل Lineالباب بخط طار إيجب علينا رسم حدود 

 
 .الباب جانبي جدران خطوط رسم( 78 -2شكل )

اب باستخدام الخطوط التي تم رسمها بيمران على الن ياللذيجب علينا عمل قص للخطين 

 .Trimأمر  اب باستخدامبحول ال

 
 الباب طرافأ من الاستفادة يمكن ذلكك ،مدخلًا يكون نأ ليتسنى الجدران خطوط حذف( 79 -2شكل )

 .موضح هو كما الجدار لخطوط Cutting Edge ليكونا
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 لانه ألا إننا غيرنا حجمه أرغم  ه وعلىنلأ D1علينا بتفجير الباب خيرة أكخطوة  ذلكك

 Block أمرعمله بعادة إومن ثم  Explode أمرلذا عليك بتفجيره ب Block D1زال البرنامج يعتبره 

 .مثلا D2 اًجديد اًاسمعطائه إو

الدخول في تفاصيل الرسم سينتهي بك المطاف بهذه النتيجة بسنحت لك الفرصة ن أبعد 

 .(80 -2)النهائية كما في الشكل 

 

 .للتمرين النهائية النتيجة( 80 -2شكل )
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 تمارين الوحدة

 Coordinateـ لا أوامرباستخدام دنى أقم برسم الشكل  .1

 
 

 .الموضحة بالصورة المرفقة بالمليمترالمقاسات ن إحيث فرنجي إ مرحاض مسقطرسم  .2
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 .الشكل المرفقتمام إبقم  .3
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 نموذج تقييم المتدرب لمستوى أدائه

 تمارين الوحدةالانتهاء من يعبأ من قبل المتدرب نفسه وذلك بعد 

، قيم نفسك وقدراتك بواســـطة  أوامر الرسم والتعديلوحدة بعد الانتهاء من التدرب على 

التقييم الذاتي بعد كل عنصر من العناصر المذكورة، وذلك بوضع عـــــلامة إكمال هذا 

( أمام مستوى الأداء الذي أتقنته، وفي حالة عدم قابلية المهمة للتطبيق ضع العلامة في )

 الخانة الخاصة بذلك. 

 العناصـــــر م

 مستوى الأداء 

 )هل أتقنت الأداء(

غير قابل 

 للتطبيق
 كليا جزئيا لا

     الأوامر. باستخدامالرسم والتعديل   1

     الأوامر بشكل صحيح. استخدام  2

     .صغيرة وحفظها واستدعائها تفصيلهرسم   3

     رسم مسقط صغير وتطبيق الأوامر عليه.  4

     واجهة باستخدام المسقط.  5

أو  الكليدرجة الإتقان إلى  يجب أن تصل النتيجة لجميع المفردات )البنود( المذكورة

"جزئيا" فيجب إعادة التدرب أو  أنها غير قابلة للتطبيق، وفي حالة وجود مفردة في القائمة "لا"

 على هذا النشاط مرة أخرى بمساعدة المدرب.
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 نموذج تقييم المدرب لمستوى أداء المتدرب

 تمارين الوحدةالانتهاء من يعبأ من قبل المدرب وذلك بعد 

 ...............................................اسم المتدرب : 
 

 ..............................التاريخ: 

 ..............................................رقم المتدرب  :
 المحاولة :

 العلامة: 

1 2 3 4 

... ... ... ... 

 نقاط 10مفردة يقيم بـ أو  كل بند

 من مجموع النقاط. %100الحد الأعلى: ما يعادل      من مجموع النقاط. %80الحد الأدنى: ما يعادل 

 بنود التقييم م
 النقاط )حسب رقم المحاولات(

1 2 3 4 

     الرسم والتعديل باستخدام الأوامر.  1

     استخدام الأوامر بشكل صحيح.  2

     رسم تفصيله صغيرة وحفظها واستدعائها.  3

     وتطبيق الأوامر عليه.رسم مسقط صغير   4

     واجهة باستخدام المسقط.  5

     المجموع

 ملحوظات:   

............................................................................................................ 

............................................................................................................ 

 توقيع المدرب: .............................
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 الثالثةالوحدة 

 استخدام الطبقات والكتل
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 ةالثالثالوحدة 

 الطبقات والكتل ماستخدا

  العام للوحدة: الهدف

ستخدام الطبقات لاالأساسية المتدرب المعلومات والمهارات إكساب إلى  تهدف هذه الوحدة

 .والكتل

  التفصيلية: الأهداف

 :أن علىوبكفاءة  في نهاية هذه الوحدة التدريبية أن يكون المتدرب قادراً من المتوقع

 .الهندسيةكل عنصر من عناصر الرسوم خاصة ب تالتطبيقانشئ ي .1

 .أشكال وأحجام وألوانالخطوط من خصائص  يطبق .2

 .ستخدم الطبقات أثناء الرسمي .3

 .Blocksالتعامل مع الكتل  يشرح كيفية .4

 ساعات تدريبية. 20 على هذه الوحدة: بالمتوقع للتدري الوقت

 الوسائل المساعدة: 

 .A5دفتر مربعات بحجم  .1

 .مع ملحقاتهلي آجهاز حاسب  .2

 .جهاز عرض بياناتأو  شبكة تعليمية .3
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 مقدمة

الترابط بين  ورأينابعضها نا أنشأوفي الفصل الماضي تعلمنا كيفية التعامل مع الرسومات 

وليس نهاية المطاف  يلا يكفالرسومات نشاء إوعدد الخيارات الخاصة بالتعديل. ولكن  وامرالأ

فلذا نحن بحاجة  ،فنسبة التعديل على الرسومات ونسخها وتعدادها يفوق نسبة الرسم نفسها

طريقة لتنظيم هذه الرسومات بالطريقة التي تسهل علينا وعلى الفرد الذي سيستخدم  لإيجاد

ابطة يقوم فالرسوم الهندسية سلسلة طويلة متر ،عن عملناهمية أ للا يقرسوماتنا لينجز عمل 

 مجموعة من المهندسين والفنيين لتتمم لنا حلقة المشروع. بإنشائها

بالطبقات المرسومة على ورقة الشفاف والتي تسمح لك برؤية جميع شبه أهي  :Layersالطبقات 

الرسوم من خلالها في وقت واحد ولكن في نفس الوقت تجمع العناصر والرسومات حسب 

 .(1 -3شكل )الجدران، المحاور ...إلخ. انظر  ،ثاثالأالصنف المصنوعة له كمثال: 

 
 ،بوابأو جدران من المسقط الجانب تمثلالأولى  طبقات 3إلى  المياه دورة تقسيم الشكل لنا يوضح (1 -3شكل )

 نأ يأ متقطع بخط ورسمها المياه دورة ستارة تمثل الثالثة الطبقة استحمام وحوض ومرحاض مغسلة من ثاثالأ يمثل الثاني

 .م1.60 من علىأ منسوبها
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 Layerالوصول للأمر 

كما هي موضحة  Home>Layer> Layer propertiesالرئيسة  وامرالأمن خلال قائمة 

 . (2 -3شكل )بال

 
 .مرالأ موقع الصورة توضح( 2 -3شكل )

 ،رسومات وخرائط هندسيةنشاء إمهامك من  لإنجازسيسهل عليك استخدام الطبقات 

تعمل على خرائط معمارية وقد نك أسيسهل عليك فصل العناصر على سبيل المثال لو  ذلكوك

.إلخ( ولكن تم إنشاء تغيير مكان ..للأرضيات ،للأسقف ،عدد طبقات ) طبقة للجدرانت أنشأ

هو تشغيل  كما عليسبب كان. سيتوجب عليك المراجعة لتفحص التغيير وحينها كل ي لأالجدار 

مر الأعلى سبيل المثال. سيجعلك هذا  للإنارةالتعديل المناسب جراء لإ بالأسقفطبقة الخاصة 

 بهذا التغيير. تتأثروتفاصيل المشروع التي لم جزاء أتتفادى الخوض بين 

محدود من الطبقات، ويمكنك تسميتها كيفما  يسمح لك بعدد لا AutoCADبرنامج الـ

 = , | * ? ; : " \ / < > :وهي: ستخدامها ايمكن  تشاء ولكن هناك عدد من الرموز التي لا

 الكتابة باللغة العربية.أثناء وهذا سيعيقك  .'

 .Layer Propertiesبالنقر على أو  LAندخل  Command  مرأعن طريق  .1

مبدئيا ( 3 -3شكل )الكما هي موضحة على  Layerة خاصة بالقائمة فذستفتح لنا نا .2

أو  زرقأأو  حمرأكان ن إبالقلم الذي بيدك شبه أيتضح لنا اسم الطبقة ولونها الحالي. 

 .الرسم تدواأمن ي أفهذا اللون الظاهر هو الذي يظهر لنا عند استخدام  ،خضرأ
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 .الطبقة اسم يمثل فهو 0 ماأ الحالي الطبقة لون يمثل سودالأ اللون( 3 -3شكل )

بالنقر على الجزء الموضح  ذلكو New Layerطبقة جديدة  بإنشاءمباشرة  نبدأ .3

 .(4 -3شكل )بال

 
 . New Layer مسمى تحت بالشكل الموضح الرمز على بالنقر جديدة طبقة ضافةإ( 4 -3شكل )

دخال مجهز لإنه أي أالنص مظلل ن أبنلاحظ  Layer1الطبقة الجديدة تظهر تحت مسمى 

 مع استخدامه. اًيكون متناسبن أوالذي يجب  الاسم الخاص بالطبقة الجديدة

 

تكون الأولى  المجموعة ،مجموعات 3لـ ةعادتسمية الطبقات تقسم الطبقات  ملاحظة

جزاء الأالطبقة المشار لها هنا هي جزء من ن أ ذلكونقصد ب ،خاصه بالصنف

كما هي  الثانيةالمجموعة ما أإلخ. ...الكهربائيةأو  نشائيةالإأو  المعمارية

وهي جزء من  اًتعني جدار Wall نإحيث  )1 -3(موضحة لدينا بشكل

إلى  تشير المجموعة الثالثة والتيما أ. Architecture الخرائط المعمارية

من أو  قد تكون مثلا جدران مصنوعة من الجبس بوردضافية إتفاصيل 

 فيكون التفصيل في المجموعة الثالثة.حمر الأالطوب 
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 .مجموعات 3لـ مةمقس طبقة كل نأ الصورة توضح ) 1 - 3 (شكل

 

 

 وليس الحصر.مثلة الأهنا بعض التصنيفات وهي على سبيل 

 الرمز الصنف النوع تفاصيل )اختياري(

BRECK Wall Architecture A 

400MM ×400MM Column Structure S 

SPOT Light Electrical E 

HADRONIC Elevator Mechanical M 

A/C Duct Heating, 

Ventilation 

and Air 

Conditioning 

HVAC 

8MM Wire Mechanical 

Electrical 

Plumbing 

MEP 

 

 

 

 الخرائطجدار وهو جزء من نه أوتعني  A-Wallأدخل اسم الطبقة على النحو التالي  .4

 .ةالمعماري

 لوانالألفتح قائمة ( 5 -3شكل )البعد تسمية الطبقة قم بالنقر على اللون كما في  .5

 

 
 .لوانالأ قائمة لتفتح اللون على انقر( 5 -3شكل )
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بتدرجات مختلفة ولكن بأسفل النافذة جانب لوان الأهناك مجموعة من ن أنلاحظ  .6

هناك مجموعة محددة وهذه المجموعة تعتبر المجموعة الافتراضية  ByLayerكلمة 

ن الآما أباستفاضة.  ذلكويمكن الاستفادة منها في الطباعة وسنشرح  ،الرئيسة للبرنامج

 . OKخضر ثم الضغط فنكتفي باختيار اللون الأ

 
 .الافتراضية لوانالأ مجموعة( 6 -3شكل )

على أفي  Xبالنقر على رمز  ذلكو Layer Properties Mangerغلاق صفحة إن علينا الآ .7

 .النافذة

 الأخضر.باللون  تطبقة الجدار وأصبح تتغيرن قد الآ .8

 خضر.سيكون باللون الأينسخ تحت هذه الطبقة أو  ي عمل يرسمأن وصاعدا سيصبح من الآ

 Layer Properties Manger شرح واجهة

ولكن التركيز على الجزئيات التي تنجز  ،الأولى دارة الطبقات للوهلةإربما تبهرك نافذة 

 مما ستقوفكما طبقنا بالتمرين السابق هو  ،بالتركيز عليه مما تقوساسي هي أمهامك بشكل 

المخطط  بإظهاروتدريجيا سنقوم بتعديل بعض العناصر التي تساعد  ،بفعله بشكل عام ومستمر

 بشكل جيد.
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وحذف وتحديد العناصر كما هي  لإنشاءربع قوائم أهنالك ن أب (7 -3)نلاحظ بالشكل 

القائمة حيث يعطي  بأعلىالشريط  ىما معننبين ( 8 -3)بالشكل ما أموضحة على الصورة، 

 فكرة عامة عن ماهيته.

 
 تحديد ،الطبقة حذف ،الطبقة تجميد ،جديدة طبقة نشاءإ وكيفية القائمة بأعلى يقوناتالأ شرح( 7 -3شكل )

 .الطبقة

 
 .ومعانيه للجدول شرح( 8 -3شكل )

اختيار سماكات وتوكاد الأيتيح لك برنامج  ،الطباعة الافتراضيمر أتحديد  ملاحظة

بتحديد خيار  ذلكو ،للخطوط بشكل افتراضي يساعدك على توفير الوقت

Color-dependent style  لوان بناء على افتراضية للأ اًسيعطي قيمنه إحيث

 الجدول التالي:

Color Lineweight 

Color 9 0.05 mm 
Color 8 0.09 mm 

Red 0.1 mm 
Yellow 0.2 mm 

Green 0.4 mm 
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Cyan 0.5 mm 

Blue 0.7 mm 
Magenta 1.0 mm 

 

 نوع خطإضافة 

والخط  Color 9وسيكون لونها  Axesالمحاور  باسمسننشئ طبقة ولا أنوع خط  لإضافة

  _._._._شرطة( ، سيكون من نوع )شرطة، نقطة

 .(9 -3)شكل  ،التي سنغير لونهاجزاء الأنحدد  .1

 Axesونسميها  New Layerننشئ طبقة جديدة  Layer Properties Mangerمن قائمة  .2

 .وتعني محاور

 
 .جديدة لطبقة اضافتهإ المراد العناصر تحديد( 9 -3شكل )

 .OKعلى  ثم انقر Color 9تغيير اللون للون  .3

 .Continuousننقر على كلمة  Linetypeتحت قائمة  .4

 .(10 -3)ستفتح قائمة كما في الشكل  .5
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 . Load على انقرأو  القائمة ضمن من كان نإ الخط نوع تحديد( 10 -3شكل )

خطوط جديدة، ثم نحدد الخط حسب النوع الذي نواع ألتحميل  Loadسننقر على 

 .OKثم انقر ( 11 -3)نريد كما ذكرنا في بداية التمرين انظر الشكل 

 
 القائمة من الخط نوع نختار( 11 -3شكل )

 .OKسيضاف الخط الجديد، حدده ثم انقر  .6

 (.0.05mm)ونغيره لتكون  Line Weightنغير سماكة الخط من قائمة  .7

 .Layer Properties Mangerإغلاق قائمة  .8

تقلق فالمشكلة تكون  عدم ظهور الخط كما هو متوقع فلاحيان الأربما ستواجه بعض 

   وامرالأولتعديل خصائص الخط بإمكانك الذهاب من قائمة  Line Scaleبسبب 

Home>Properties   0.05إلى  1ثم قم بتعديل حجم الخط من  (12 -3)كما في الشكل 
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إلى  6.... 2.أو  1.من القيم مثل  اًانقاصه فجرب عددأو  زيادة الرقم بإمكانك كما يناسبحسب 

 .كما يناسبتجد ن أ

 
 الخط حجم لتعديل سنحتاج حيث للخط الخصائص قائمة من الخط ضبط عادةإ نستطيع( 12 -3شكل )

Linetype Scale . 
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 Layer Mangerالمصطلحات الموجودة بقائمة جدول يشرح 

 SHOW معلوماتها بكامل الحالية الطبقات سرد

 NEW جديدة تطبقا إنشاء

 DELETE حالة طبقة إلغاء

 CURENT الحالية الطبقة هي المختارة الطبقة جعل

 SHOW DETAILS الطبقات عن التفصيلية المعلومات سرد

 HIDE DETAILS الطبقات عن التفصيلية المعلومات سرد إلغاء

 SAVE STATE الحالية الطبقات حالة حفظ

 RESTORE STATE سابقا المحفوظة الطبقات حالة استدعاء

 ALL LAYERS SHOW للرسمة الحالية الطبقات جميع سرد

 المستعملة الطبقات سرد
SHOW ALL USED 

LAYERS 

 ON الشاشة على الطبقة عرض

 OFF الشاشة على الطبقة عرض عدم

 COLOR للطبقة محدد لون تعيين

 LINETYPE للطبقة خط نوع تعيين

 LINEWEIGHT الخط سماكة تعيين

 لا ولكن الشاشة على مشاهدتها نستطيع بحيث الطبقة غلق

 عليها تعديلات أي إجراء نستطيع
LOCK 

 UNLOCK الطبقة غلق منع

 موجودة غير وكأنها تماما البرنامج يهملها بحيث الطبقة تجميد

 الرسمة قراءة سرعة على يساعد مما
FREEZE 

 THAW التجميد إلغاء
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 :تمرين

 قم بتعديل الطبقات للمخطط المرفق بحيث يكون كالتالي:

 نوع الخط لون الطبقة  اسم الطبقة الطبقةوصف 

 Axis Color 9 Long-dsh dot المحاور

 A-Wall Cyan Continuous الجدران

 Furniture Red Continuous الأثاث

 Door Green Continuous الأبواب

 

 

 .( الشكل المطلوب13 -3شكل )



 مبادئ الرسم بالحاسب

 

 رسمع 011

 

 
129 

 Propertiesقائمة 

من هنا يتم تعديلها. ولكن  إذ ،مخصصة لتعديل الخصائص الخاصة بالخطهذه القائمة 

تميز بين تغيير اللون في هذه القائمة وتغيير اللون من قائمة ن أوهو  ،جدا اًضروري اًمرأهناك 

Layer تغييره هنا يندرج تحت خصائص  مما يتن لأLayer .ولكن العكس غير صحيح 

 
 .تفاصيلها وشرح Properties قائمة( 14 -3شكل )

بتغيير نوع ، على سبيل المثال ،التعديل في هذه القائمة يعتبر من الخصائص الفرعية للطبقة 

 بلا يجولكنها  Long-dash dotالخط الخاص بالمحاور ستتغير معها دوائر المحاور وستصبح 

ن أولكن فقط نريدها  Axisضمن طبقة  لإبقائهالذا فنحن بحاجة  ،تكون بهذه الطريقةن أ

 :تيبالآتغير نوع الخط الخاص بالمحاور ففي هذه الحالة نقوم 

 تحديد الدوائر الخاصة بالمحاور .1

 .Propertiesمن قائمة  .2

 
 الجزء على المحور دائرة ماأ( ونقطة خط) المحور خط يبين يمنالأ الجزء في الخطين بين الفرق نلاحظ( 15 -3شكل )

 (اًمستمر اًخط) تكون يسرالأ
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 .Continuous اًمستمر اًنقوم بتعديل نوع الخط ليكون خط .3

 .Esc بالكبس على مفتاحمر الأننهي  .4

الخط دون تغيير الخط نفسه من قائمة عدادات إقد أنهينا تغيير نوع الخط من كون نوبهذا 

خطوط بدون نواع أو ألوان. وهذه الطريقة عملية جدا لتغيير بعض العناصر من Layerالطبقات 

 الموجودة في قائمة الطبقات. الرئيسة بالإعداداتالمساس 

منها بما يتناسب مع معناه. لذا عليك  يأاختيار  وبالإمكاننواع كثيرة من الخطوط أهناك 

إلى  نها توصل رسالةمعانيها لأ يها المتدرب البحث والتعرف على معنى هذه الخطوط وحفظأ

المتلقي. سنعرض مجموعة الخطوط الافتراضية الموجودة على البرنامج لتتمكن من الرجوع لها 

 .(16 -3)وترجمة معانيها بنفسك. انظر الشكل 

 
 . AutoCAD برنامج في الموجودة الافتراضية الخطوط نواعأ( 16 -3شكل )



 مبادئ الرسم بالحاسب

 

 رسمع 011

 

 
131 

 Wblock مرأ

واختصاره  Write Blockمر أمن خلال  ذلكبالإمكان حفظ ملف لبلوك بشكل مباشر و

W نشاء مكتبة إمر على بعد تحديد العنصر واختيار مكان حفظ الملف. يساعد هذا الأ ذلكو

 بشكل سريع والتي تساعدنا في استدعائها في كل مرة أردنا الكتل المشابهة لها. 

للرجوع له في كل  ”Library“أو  نشاء ملف باسم "مكتبة"إلذا فسيكون من العملي جدا 

 مرة.

للحفظ  اًولكن هذه المرة ستعين مكان Blockثناء عمل أهي  فالخطوات كما ذلكولعمل 

 . OKفيه ومن ثم اعتماده بالنقر على 

 
 . Wblock مرأإدخال ب ذلكو Block كتلة يأ حفظ عند dwg ملف بإضافة الخاصة النافذة( 17 -3شكل )

 كيف تنشئ نافذة؟

ن نقوم بعمل نافذة أفهنا نريد  ،به ةطبقة خاصنشاء إعنصر جديد يتوجب عليك ي أ لإنشاء

 ثانيا،هي المواصفات لهذه النافذة قبل البدء برسمها.  ولا ماأن تعرف أبحجم الباب ولذا يجب 

 زفما نرك ،لنافذة اًما الذي سترسمه فهنا في هذا المثال سنرسم مسقط ن تعرفأيتوجب عليك 

لذا تكون  ،ارتفاع النافذة فلن نرسمهأو  الجلسةنكترث لارتفاع  عليه هو عرض النافذة ولا

ن النوافذ أهي طريقة رؤيتك لهذا العنصر. ثالثا،  ن تعرف ماأي عنصر على بينة عند رسمك لأ
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فعند البدء برسم نافذة تتأكد من  ،ذلكلم يتم تبين خلاف  ار مافي الغالب تكون بوسط الجد

 .دارةإبتوسيطها باستخدام  ذلكوضعها بالمنتصف و

Osnap 

 استخدم هذا الجدول لمعرفة بيانات النافذة:

 الشرح الجلسة العرض الطول اسم العنصر

W1 2 1.90 0.20 نافذة سحاب 

 :الخطوات

 .  A-Windowsباسم   New Layer ن ننشئ طبقة جديدةأقبل البدء يجب  .1

 
 حيث الشريط على لك وستظهر مامهاأ  علامة بظهور ذلكو نشطة لتصبح مرتين الطبقة على ننقر( 18 -3شكل )

 .للاستخدام جاهزة نهاإ

 .وتحديد منتصف الجدار Lineمر أقم باختيار  .2

 
 . Midpoint الـ تشغيل من التأكد مع Osnap مرأ تفعيل( 19 -3شكل )

 خضرالأليساعدنا على تحديد منتصف الجدار بظهور علامة المثلث باللون  ذلكو Osnapمر أنفعل ) 2 - 3(شكل 

Midpoint . 

 سيصبح لدينا هذه المعادلة ي أ 2بقسمتها على  ذلكنقوم بتقسيم عرض النافذة و .3

0.95m =
1.90

2
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 . 0.95وننشئ خطين متوازيين من كل جانب بمسافة  Offsetمر أنستخدم  .4

 
 . 2 على الشباك عرض قسمة ناتج هو Offsetالـ قيمة( 20 -3شكل )

 . Trimمر أنقص جزء الجدار باستخدام  .5

 
 .الخطوط زحام تقليل على يساعد الجدار وسط تنظيف( 21 -3شكل )

 .م0.05متر وستكون إلى  نحولهاي أسم 5نقوم بإنشاء كتفين من كلا الجانبين بمسافة  .6

 
 .لاحقا بها الخاصة التفاصيل رسم عليك يسهل النافذة طارإ( 22 -3شكل )

 .يسرالأإلى  يمنالبرواز الأمن  اًفقيأ اًنرسم خط .7

 
 .الزجاج يمثل هذا( 23 -3شكل )
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 . 0.05للأعلى وأسفل الخط بمسافة  offsetعمل  .8

 
 .النافذة شريحتي سماكة عن عبارة هي( 24 -3شكل )

 .نصنع الشكل المقابل Filletمر أباستخدام  .9

 
 .بالسحب تفتح النافذة نأب توضح الخطوة هذه( 25 -3شكل )

 (.0.05)نشاء خط بطول إبكتاف الأنغلق  .10

 
 .البرواز أطراف غلاقإ( 26 -3شكل )

 . W1باسم نافذة  Blockنشاء إنختم العمل ب .11

نشاء إعنصر جديد يجب عليك ي أشاء إنعند البدء ب هنأتعلمنا من خلال هذه الخطوات 

لوان الأضبط أسني أبتقل  وتبدأ الرسم باستخدام الطبقة الجديدة ولا ،طبقة خاصه به

كد دائما من البدء بالطريقة ألذا ت ،نها تستغرق وقتا طويلا لتعديلهالإ ،لاحقا)الطبقات( 

 الصحيحة لتتفادى التعديل لاحقا.
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 تمارين الوحدة

صادر للحصول على المقاسات الصحيحة ثم قم المإلى  مع الرجوعالأثاث من أشكال  3ارسم 

 . Blockبعمل 
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 نموذج تقييم المتدرب لمستوى أدائه

 يعبأ من قبل المتدرب نفسه وذلك بعد الانتهاء من تمارين الوحدة

، قيم نفسك وقدراتك  الطبقات والكتل موحدة استخدابعد الانتهاء من التدرب على 

بواســـطة إكمال هذا التقييم الذاتي بعد كل عنصر من العناصر المذكورة، وذلك بوضع 

( أمام مستوى الأداء الذي أتقنته، وفي حالة عدم قابلية المهمة للتطبيق ضع العلامة عـــــلامة )

 في الخانة الخاصة بذلك. 

 العناصـــــر م

 مستوى الأداء 

 )هل أتقنت الأداء(

غير قابل 

 للتطبيق
 كليا جزئيا لا

     .إنشاء الطبقات الخاصة لكل عنصر من عناصر الرسم  1

     .تعديل خصائص خطوط الرسم  2

     .استخدام الطبقات بشكل صحيح أثناء الرسم  3

     .كتل وحفظها بملف منفصلإلى  تحويل الكائنات  4

أنها أو  درجة الإتقان الكليإلى  يجب أن تصل النتيجة لجميع المفردات )البنود( المذكورة

"جزئيا" فيجب إعادة التدرب على أو  غير قابلة للتطبيق، وفي حالة وجود مفردة في القائمة "لا"

 هذا النشاط مرة أخرى بمساعدة المدرب.
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 نموذج تقييم المدرب لمستوى أداء المتدرب

 تمارين الوحدةالانتهاء من يعبأ من قبل المدرب وذلك بعد 

 ...............................................اسم المتدرب : 
 

 ..............................التاريخ: 

 ..............................................رقم المتدرب  :
 المحاولة :

 العلامة: 

1 2 3 4 

... ... ... ... 

 نقاط 10مفردة يقيم بـ أو  كل بند

 من مجموع النقاط. %100الحد الأعلى: ما يعادل      من مجموع النقاط. %80الأدنى: ما يعادل الحد 

 بنود التقييم م
 النقاط ) حسب  رقم المحاولات (

1 2 3 4 

1  
إنشاء الطبقات الخاصة لكل عنصر من عناصر 

 .الرسم

    

     .تعديل خصائص خطوط الرسم  2

     .أثناء الرسماستخدام الطبقات بشكل صحيح   3

4  
كتل وحفظها بملف إلى  تحويل الكائنات

 .منفصل

    

     المجموع

 ملحوظات:   

............................................................................................................ 

............................................................................................................ 

 توقيع المدرب: .............................
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 الرابعةالوحدة 

 إضافة الأبعاد والنصوص وتظليل الرسومات
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 الرابعةالوحدة 

 والنصوص وتظليل الرسومات بعادالأ ةإضاف

  العام للوحدة: الهدف

 بعادالألإضافة المتدرب المعلومات والمهارات الأساسية إكساب إلى  تهدف هذه الوحدة

 تظليل الرسومات.والنصوص و

  التفصيلية: الأهداف

 :أن علىوبكفاءة  في نهاية هذه الوحدة التدريبية أن يكون المتدرب قادراًتوقع الممن 

 .على الرسومات المعمارية بعادالأ يطبق .1

 .بعادنسق الخطوط والأي .2

 .بعادللأمختلفة  اًنماطأنشئ ي .3

 .بعادالأدوات أستخدم ي .4

 .ستخدم النصوص في الرسوماتي .5

 .مختلفة للنصوصنماطا أنشئ ي .6

 .بعد كتابتها ق النصوصينس .7

 .المناسبة وامرالأظلل باستخدام ي .8

 

 ساعات تدريبية. 20 على هذه الوحدة: بالمتوقع للتدري الوقت

 الوسائل المساعدة: 

 .A5دفتر مربعات بحجم  .1

 .مع ملحقاتهلي آجهاز حاسب  .2

 .جهاز عرض بياناتأو  شبكة تعليمية .3
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 Textالنصوص 

 مقدمة

على الكثير من النصوص بعضها للتعريف بالمشاريع معظم الرسومات المعمارية تحتوي 

اللوحة ...إلخ. وبعضها لإعطاء معلومات  مساالمشروع،  موعناصره مثل تحديد اسم المالك، اس

تضاف النصوص  ذلك. كحجامهاأوالتشطيبات نواع أمحددة من الرسومات مثل جزاء أعن 

 خدام لها.لتبيين نوع الاستنشائية والإلأسماء الفراغات المعمارية 

 الرسم:إلى  اضافة النصوص أوامر

 للتعامل مع النص.ن اطريقتهناك وتوكاد الألإنشاء النصوص في برنامج 

 .Single line Textإنشاء سطر واحد  .1

 .Multiline Textإنشاء فقرة  .2

 Single line Textإنشاء سطر واحد : الأولىالطريقة 

 سوف نسمي رؤوس المحاور 

 :الخطوات

 . Home> Annotation> Text>Single textمن قائمة  .1

 
 نختار ثم القائمة لنا لتظهر Text جانب السهم على وننقر Annotation قائمة من مرالأ اختيار( 1 -4شكل)

Single Line . 

 ستظهر لنا الرسالة التالية: .2

Specify start point of text or [Justify/Style:] 

 حدد نوع الخطأو  ولىالنقطة الأحدد 
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 .رةأيسر للفالأبالنقر على الزر  ذلكوالأولى  سنحدد النقطة

 
 ى.ولالأ النقطة لنحدد  الصورة في كما الدائرة جانب على رقنن( 2 -4) شكل

 .0.50ارتفاع النص وسوف ندخل قيمة  وستظهر لنا هذه الرسالة ومفادها ما ه .3

Specify height <0.50>: 0.5 

 .0سيطلب منا البرنامج تحديد زاوية لهذا النص والتي ستكون  .4

Specify rotation angle of text <0>: 0 

 .لتسمية المحور Aندخل النص المطلوب وهو  .5

 .Escبالنقر على مر الأنهي  .6

 .(3 -4) نقوم بنسخ هذا النص للمحاور المجاور كما في الشكل ذلكبعد 

 .COنسخ مر أ .1

 .الدائرة ثم انسخسفل أحدد نقطة التحريك فلتكن  .2

 
 . COPY النسخ مرأ باستخدام( 3 -4) شكل

 .Esc بالنقر علىمر الأنهي  .3

  .جديةالأنعيد التسمية 
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 .التسمية نعيد( 4 -4) شكل

  .المحاور المقابلة نسخ التسمية لرؤوسننقوم بتحديد الكل و

 لدينا عدة خيارات لتحديد موقع النص 

 .Single Line Textالأمر  لتحديد محاذاة النص عند استخدام

 :التاليةسيعرض علينا أوتوكاد الرسالة  Textالأمر  أنبدعندما 

الأربعة عشر  فإن أوتوكاد سيعرض علينا الخيارات ثم ضغطنا مفتاح، j وإذا اخترنا حرف

 :وهيص ناللمحاذاة 

Specify start point of text or [Justify/Style]: j 

 Alignسيطلب الأوتوكاد منك تحديد نقطتين ثم يقوم بمحاذاة النص بين هاتين النقطتين 

 ،وزاوية الخط التخيلي الذي يربط بين النقطتين اللتين حددتهما ستكون زاوية تدوير النص

فإن  ،النقطتينولأن النص الذي تدخله سيتم تعديل حجمه بحيث يتناسب تماماً بين هاتين 

وسيظل ارتفاع وعرض النص لكل حرف كما  ،تحديد ارتفاع النصك نمأوتوكاد لن يطلب 

 . هو

Enter an option 
[Left/Center/Right/Align/Middle/Fit/TL/TC/TR/ML/MC/
MR/BL/BC/BR] 

Fit   مشابه للخيارهذا الخيار Align  هذا  دما تحددنفع ،الاختلافاتالسابق ولكن مع بعض

زاوية تدوير  تحديد نقطتين على الرسم ويستخدمها لتحديدك نمسيطلب  أوتوكادالاختيار فإن 

تحديد ارتفاع  فإن أوتوكاد سيطلب منك ،السابق Align ولكن على عكس خيار ،النص

النص الذي تكتبه  الحروف حتى يتمكن من إدراجضغط أو  النص وسيقوم أوتوكاد بتمديد

 . بين النقطتين اللتين حددتهما
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 ٠ وسيطلب منك تحديد زاوية وارتفاع النص .توسيط النص مع نقطة المركز التي حددتها 

 Middle هذا الخيار يشبه خيار Center السابق ولكن بدلًا من وضع نقطة منتصف سطر 

 ،المحددة فإن أوتوكاد سيقوم بتوسيط النص أفقياً عند النقطة ،تحددهاالنص عند النقطة التي 

 .لنصل ورأسيا بحسب أعلى وأدنى نقطة

 Right عند  يقوم بمحاذاة النص من ناحية اليمين وسيضع أوتوكاد الجانب الأيمن من النص

 .النقطة التي تحددها ثم يمتد النص من ناحية اليسار

TL/TC/TR إلى  الثلاث ترمزلخيارات ا هذه( Top Left و )أعلى اليسار (Top center   أعلى

رأسياً بحيث  الأحوال سيحاذي أوتوكاد النصكل بأعلى اليمين ( Right Top ) و المنتصف(

منتصف النقطة أو  يسار ويحاذيه أفقياً يمين أو تحددها،تكون أعلى نقطة فيه عند النقطة التي 

 .الثلاثة تختاره من بين هذه الخياراتالتي تحددها بحسب الخيار الذي 

ML/MC/MR إلى  هذه الخيارات ترمزMiddle Left) اليسار( و فمنتص  Middle) Center 

الثلاثة السابقة  منتصف اليمين( وهي متطابقة مع الخيارات( Right Middle منتصف الوسط( و

 .فيهأوتوكاد سيقوم بمحاذاة النص رأسياً من نقطة الوسط وليس من أعلى نقطة فيما عدا أن 

BL/BC/BR  إلى  هذه الخيارات ترمزBottom Left) اليسار ( و لأسف Bottom Center) أسفل

 TL/TC/TR أسفل اليمين( هذه الخيارات مشابهة للخيارات  Bottom Right) المنتصف( و

 .التي تحددها النص مع النقطة في يقوم بمحاذاة أدنى نقطةالسابقة فيما عدا أن أوتوكاد 

. 

 .بالاختصارات الخاصة ناطقالم تحديد( 5 -4شكل)
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  Multiline Text:الطريقة الثانية -2

 :Multiline Textالأمر  إلى الوصول

 Home>Draw>Text> Multiline Text  من شريط القوائم الرئيسة

 .T  بالاختصار بكتابة

 :خطوات

 :ستظهر لك الرسالة التالية حد الطرق السابقةأبالأمر  قم بتفعيل

Specify first corner:  

 :ستظهر لك الرسالة التاليةو لموقع النص. حدد الموقعالأولى  يطلب أوتوكاد تحديد الزاوية

Specify opposite corner or [Height/Justify/Line 
spacing/Rotation/Style/Width/Columns]:  

 :ستظهر لك النافذة التالية حدد الموقع النص.يطلب أوتوكاد تحديد الزاوية الثانية لموقع 

قم بكتابة النص المطلوب في منطقة الكتابة واستخدم الأدوات الموجودة في النافذة لتنسيق 

 .مرالألينتهي  OK لنص ثم اخترا

 

 
 .النص بقائمة يقوناتالأ شرح( 6 -4) شكل

  Style Text إنشاء أنماط مختلفة للنصوص

 احتياجكأكثر حسب أو  الرسم يجب عليك إنشاء نمط نصيإلى  بإضافة نص أتبدقبل أن 

ويمكن اعتبار الأنماط  ،الحرص على كتابة اسم لكل نمط تنشئه حسب استخدامه مع

حفظ إعدادات ارتفاع النص  النصية طريقة لحفظ التنسيق النصي الذي تستعمله حيث يمكنك

 .التي ترغب بإضافتها للنص التأثيراتونوع الخط وجميع 
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  :الخطوات

بالنقر على السهم المجاور  ذلكنقوم بتكبير القائمة و  Home> Annotationمن قائمة  .1

 .stعن طريق الاختصار أو  Annotationلكلمة 

 

 
 .القائمة هذه من  Text style إضافة تمت( 7 -4) شكل

  :خيارات 4ستظهر لنا  

 .Text Styleنمط النص  .1

 .Dimension Style بعادنمط نص الأ .2

 .Multileader Styleشارة الإنمط النص ذو  .3

 .Table Styleنمط النص الخاص بالجداول  .4

نكبر القائمة بالنقر على السهم المجاور وننقر  Text Styleوهو ول الأهنا الخيار  هما سنتناول

 وستفتح لنا هذه القائمة. Manage Text Styleعلى كلمة 

 
 . Text Style بإنشاء الخاصة نافذةال( 8 -4) شكل
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 . Newسننقر على  .2

 . OK" ثم ننقر Room Nameسنعطي اسما للنص فليكن هنا " .3

 . Verdanaسنعين نوع الخط فليكن  .4

 .حسب الغرض منه(أو  ) 0.50إلى  سنغير ارتفاع الخط .5

 . Set Currentننقر على  .6

النص  يللتعد ذلكو إعداد النصثناء أ Annotativeيمكن النقر على كلمة  ملاحظة

 ل الرسم.مكيمع اتجاه العنصر وس اًوتناسب ةنسبوتغييره 

 
 كلمة على بالنقر ذلكو اوتناسب ةنسب وحجمه النص اتجاه تغيير تفعيل يمكن( 9 -4) شكل

Annotative . 

 

 :تنسيق النص

النصوص حيث يمكننا تغيير نوع تغيير إعدادات  Text Style نستطيع من خلال النافذة

حيث  ،خط النص وتأثيرات النص وتحديد حجم الخط وتباعد الحروف وتغيير زاوية ميلان النص

 .يوضح الشكل التالي خيارات النافذة

 
 .النافذة يقوناتأ شرح( 10 -4) شكل
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، لحفظ النمط الذي عملته Apply اختر النص تنسيقل بعد الانتهاء من عمل التغييرات 

 Current ولتتمكن من استخدام النمط قم بالتحديد على اسم النمط من نفس النافذة ثم اختر

 السابقة. ويمكنك إنشاء عدة أنماط باستخدام الخطوات ،ليكون النمط المحدد هو الحالي

 D1لباب  Blockتعديل على 

حسب  ذلكو -مسبقا في الفصل الثاني ذلكتم شرح  –نص على كتلة الباب ضافة إيمكن 

 الخطوات التالية:

 .الباب Blockالنقر مرتين على  .1

 .OKثم تنقر  D1ستظهر لك قائمة بالكتل الموجودة بالمشروع تختار منها  .2

اللون إلى  سودوستلاحظ تغير الخلفية من اللون الأ Block Editorسيفتح لك البرنامج  .3

 .على تعديل كتلةتعمل نك أبالرمادي والتي تشير لك 

ضمن قائمة  وامرالأالرسم وستجد قائمة  أوامرتستطيع التعامل بشكل طبيعي مع  .4

Home . 

 (.0.20)قم بكتابة اسم الباب بدائرة بمنتصف الباب بنصف قطر  .5

 (.0.20)ارتفاع النص يكون ن أبوتأكد  “ D1“قم بكتابة النص  .6

 :هو موضح بالشكل التالي كماMove مر أوسط النص باستخدام  .7

 
 . Block Editor نافذة( 11 -4) شكل

 . Close Block Editor وامرالأمن شريط غلاق إمر أالملف بالنقر على غلق أ .8

 :ستظهر لك الرسالة التالية .9
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The Change you made have not been saved. What do you want to do? 

 لم يتم الحفظ. وما تريد فعله؟ هنأبوتعني 

Save the change to D1 

 D1حفظ التغييرات على ملف 

Discard the changes and close Block Editor 

 Block Editorقائمة غلاق إوإلغاء التغيير 

 Save the change to D1 وهو حفظ التغييرول الأسننقر على الخيار  .10

 بوسط الشكل السداسي للنافذة؟  W1قم بإنشاء اسم للنوافذ  :تمرين
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 كتابة البيانات والمعلومات على المخططات 

ثناء أمور الأالمهمة والتي تبين تفاصيل مور الأكتابة البيانات والمعلومات على الخريطة من 

ننا أي أ من السطورالتنفيذ. وهذه البيانات والمعلومات عبارة عن محتوى نصي مكون من عدد 

وهنا سنكتب وظيفة الفراغ جانب  ،السطور ةالثانية لكتابة بيانات متعددسنستخدم الطريقة 

م فهكذا تدريجيا ندخل 1.90×1.50ثم نذكر طول وعرض الفراغ فهو  Entryالمدخل فسنقول 

 البيانات على كل فراغ معماري.

 
 .القطاعأو  التفاصيل والمواصفات حسب نوع المسقط( كتابة بيانات ومعلومات على الخريطة تبين بعض 12 -4) شكل

من العملي والضروري بإضافة طبقة ن أبكما ذكرنا في الفصل السابق  ملاحظة

Layer  على كل عنصر يتم رسمه فالبيانات ممكن الاستفادة منها في

الكهرباء أو  ولكننا نستغني عنها في خرائط السباكة ،الخرائط المعمارية

. فوجوده بطبقة نجزأ هنأالعمل يفترض ن لأ ئاًشيعلومات فلا تمثل هذه الم

 تجميد الطبقة. أو  منفصلة تسمح لك بإخفاء
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 الرموز 

على شريط   Symbolنقر على كلمة لمن خلال ا ذلكالنص وإلى  الرموزضافة إيمكن 

من نافذة تتيح لنا اختيار الكثير إلى  . وستظهر لنا قائمة يمكن الدخول من خلالهادواتالأ

هنالك بعض الاختصارات التي يمكن كتابة رموزها  ذلكك ،الرموز الموجودة على الجهاز

فيمكن  Diameterكتابة رمز القطر للحديد ردنا ألتوصلنا للرمز نفسه. على سبيل المثال: لو 

وهذا سيوفر  øالرمز التالي إلى  وسيتحولختصار اك  c%%الرمز التالي إدخال بدراجه إ

 اء البحث عن الرمز.عليك الوقت وعن

 
 .وتوكادالأ برنامج على استخدامها يمكن التي الرموز بعض( 13 -4) شكل

 تفقدلو  كنأي أالخاص بك لي الآتعتمد الرموز على المحتوى الموجود على جهاز الحاسب 

 . Control Panelمن خلال لوحة التحكم ضافته إتم تنوع من الرموز ي أ

 Tableإضافة جدول 

جداول الكهرباء. أو  والشبابيكبواب الألإضافة جدول للبيانات مثل جداول  جكثيرا ما نحتا

على  Tableبكتابة كلمة أو  Home>Annotation>Tableولإنشاء الجدول نقوم بالنقر على 

 . Command   وامرالأشريط 
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 بوابالأ جدول من نموذج( 14 -4) شكل

من هذا التمرين  ،عمل زاوية مطبخ )اوفيس( بالغرفة مع حوض غسيل وثلاجة وفرن :تمرين

 لتسهل علينا عملنا. Arrayو Hatchالجديدة مثل الأوامر من  اًسنتعلم عدد

  :الخطوات

 المطبخ:سطح 

 (.0.70)من جدار الحمام بمقدار  Offsetبعمل  ذلكإنشاء سطح المطبخ و .1

لنغلق المستطيل كما في الشكل  Line اًللرسم. وسنرسم خطثاث الأسنستخدم طبقة  .2

(4- 15). 

 
 .المستطيل سطح المطبخيمثل ( 15 -4) شكل

مر أباستخدام  ذلكوثاث الأليكون مطابقا للون طبقة خضر الأنغير لون الطبقة للخط  .3

Match  بالاختصار أوma. 
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 الفرن:

 .ا لأننا سنغيره لاحقا(مكانها حالي م)لا يه 0.07 رنبدأ بعمل دائرة بقط .1

 0.05تكون ن أعلى  0.10من الدائرة بحيث يكون طوله  ببأحد الجوان اًنرسم خط .2

 .خارج الدائرة كما في الشكل 0.05وداخل الدائرة 

 
 .( رأس الموقد16 -4) شكل

الفرن والخط مكان الموقد ولكن نحن بحاجة لإعادة رسمه  يمثل هذا الشــــــــــكل عين  .3

النســـــــخ المتعدد بالشـــــــكل  مر ألذا ســـــــنتعرف على  ،بعدد من الاتجاهات حول الدائرة

  وامرقائمة الرئيســـــــــــــــــــــــــــة للأال. وللوصـــــــــــــــــــــــــــول للأمر من Polar Arrayالدائري 

Home>Modify>Array>Polar Array  ــار أو   ARRAYPOLARمن خلال الاختصـــــ

 . 

 
 . Polar Array مرأإلى  الوصول طريقة( 17 -4) شكل
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 سيطلب منا البرنامج تحديد العنصر وستظهر لنا هذه الرسالة مر الأبعد النقر على  .4

Select objects: 
 بالنقر عليه ثم  ذلكقم بتحديد العنصر و

 
 .والذي نريد تكراره الموقد رأسمن  اًنباجالخط الجانبي يبين  (18 -4) شكل

 .مفادها تحديد مركز الدوران Commandبشريط خرى أستظهر لنا رسالة  ذلكبعد  .5

Specify center point of array or [Base point/Axis of 
rotation:] 

 
 .( تحديد مركز الدوران19 -4) شكل

 .مرالأنمرر الفأرة على أطراف الدائرة ليظهر لنا مركزها ثم ننقر على المركز وسيتفعل 

سيقوم البرنامج بنسخ الخط بشكل محوري وسيظهر لنا هذا الشريط مر الأبعد تفعيل  .6

 .مرات 8لينسخ لنا البرنامج الخط  8إلى  Itemالـنقوم بتغيير  ،بأعلى الشاشة

 

 
 والتي Item كلمة القائمة بأعلى فنجد النسخ مرات لتعديل Array Create القائمة هذه لك تيحتس( 20 -4) شكل

 .مرات 6 العنصر نسخ تم هنأب تعني
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 Polar بالأمر الخاص عداداتالإ بشريط المدخلة المعطيات على بناء مرات 6 الخط تكرار نلاحظ( 21 -4) شكل

Array . 

 .مرالألإنهاء  ننقر على  .7

 .ننسخها أربع مرات ليكتمل لدينا سطح الفرنن أبعمل عين واحدة للفرن وعلينا ن الآقمنا 

بنفس الخطوات  ذلكو Rectangular Arrayمر الأإلى  Polar Arrayمر الأنقوم بتغيير  .1

 .ARRAYRECT بالاختصار أو  التي اتبعناها مسبقا

 
 . Rectangular Array مرالأإلى  Polar Array مرالأ تغيير( 22 -4) شكل

 .نحدد العنصر ثم  .2

 Columnكما في الشكل حيث سيكون القوائم   Array Createستظهر لنا قائمة  .3

سية أالرللصفوف  Between 0,3والمسافة بينهما  2عدد  Rowsوالصفوف  2عدد 

 .فقيةوالأ
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 .مئوالقوا الصفوف لتعديل Array Create قائمة( 23 -4) شكل

 .Close Arrayستظهر لنا النتيجة كما في الشكل ثم ننقر على  .4

 
 .المستطيل بوسط توسط والتي النهائية النتيجة( 24 -4) شكل

 الثلاجة:

من الجدار وتغيير  offsetيكفينا عمل  0.66وهي عبارة عن مستطيل بزاوية الغرفة بعرض  

  .ثاثالأالطبقة لطبقة 

 حوض الغسيل:

وصنبور المياه  0.40×0.29فالحوض نفسه هو مستطيل بمقاس  ،عبارة عن مستطيلات

( 25 -4)انظر الشكل  0.07×0.29قاعدة الصنبور  0.40ومفتاح الصنبور قطر  0.03×0.24

 .لتتقرب الفكرة

 

 
 .وانيالأ غسيل حوض( 25 -4) شكل
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 أرضية المطبخ )البلاط(:

شارة بوجود بلاط بالمنطقة فقط للإأو  شكله الخارجيأو  المهمة هو تحديد نوع البلاطمور الأمن 

تشير ن أضروري أمر  ففي المطبخ ودورات المياه ،المشار لها ضروري جدا لتبين خصوصية المنطقة

 .Hatchجديد يسمى تهشير أمر  سنتعرف على ذلكلهما بالرسوم. ولعمل 

 .وتعني بلاط A-Tileطبقة جديدة وسمها نشئ أ .1

بمقدار بلاطتين ي أبعرض المنطقة ) 0.60ليحدد منطقة المطبخ فلتكن  ارسم مستطيلًا .2

 .(0.30×0.30بمقاس 

 
 .40 رقم البرتقالي باللون محددة المطبخ بلاط منطقة 23( 26 -4) شكل

 H عن طريق الاختصار أو  Home>Draw> Hatchمن قائمة  ذلكوالأمر  راسنخت .3

 
 . Hatchأمر  موقع( 27 -4) شكل

 ـ Hatch Createسيظهر لنا شريط باسم  .4 كما في الشكل  Patternوفيه يتم تحديد نوع ال

 .التالي
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 كبير عدد يوجد حيث الشريط يسار على موجودة Pattern قائمة نأ نجد Hatch Create قائمة( 28 -4) شكل

 .منها

ي أيرسم ن أيمكن  لاالأمر  هذان أ يأ)ستظهر لنا رسالة مفادها حدد المنطقة المغلقة  .5

غلاق إتحرص على ن ألذا يجب  ،فتحة في الشكل المحددي أكان هناك ن إتهشير 

وقبل القيام باختيار المنطقة  ،)المنطقة بالكامل لتتمكن من الرسم بالشكل الصحيح

موجود هو كما AR-PARQ1 وسوف نختار النمط Patternيجب تحديد نوع النمط 

 .(29 -4) بالشكل

 
 . AR-PARQ1 المحدد النمط اختر( 29 -4) شكل

الشكل كبير جدا ولا يظهر ن أبونلاحظ هنا  (30 -4) نحدد المنطقة كما في الشكل .6

 .على شاكلة بلاط

 
 .اخترناه الذي بالشكل ليس فهذا أخط هناك نأوك يبدو ولكن البرتقالية المنطقة تحديد تم( 30 -4) شكل
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لذا علينا  ،الشكل الذي اخترناه ولكنه بحجم كبيرهو هذا ن أبنوضح ن أوهنا علينا  .7

ونصغر القيمة من  Hatch Createالمدرج ضمن قائمة  Scaleأمر  تعديل الحجم عن طريق

 صلا يقأ)يمكنك تجربة أكثر من حجم حتى تجد ما يناسبك واحرص على  0.03إلى  1

 .البلاط بشكل كبير(

 
 . 0.03 قيمةإلى  Scale الـ تغيير( 31 -4) شكل

 .مرالألننهي  Closeننقر على  .8

 

 .والمطبخ المياه لدورة تهشير عمل بعد النهائية النتيجة( 32 -4) شكل

شكل أعلى كما هو موضح بالصورة  Bathroomالمياه قم بإنشاء بلاط لدورة تمرين: 

(4- 32 ). 
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 التهاشير واستخداماتها  رموز
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 Dimension بعادالأ

وخصوصا في  ،في الرسومات الهندسيةساسيا أوالمقاسات جزءا  بعادتعتبر كتابة الأ

 التي تتيح لك التحكم في مظهرها. بعادالرسومات التنفيذية. وهناك العديد من متغيرات الأ

 :بعادمكونات خطوط الأ

 ئهاسماأالمختلفة لخط البعد مع جزاء الأتعرف ن أيجب عليك  بعادباستخدام الأ أتبدقبل أن 

 وهي على النحو التالي:جزائها أوختلفة الم

 .طرافهاأط الذي يمثل المسافة التي تقوم برسم بعدها وينتهي بأسهم عند الخهو  خط البعد: .1

من الكائن الذي يجري رسم بعده وتبين المكان  أهي الخطوط التي تبد خطوط الامتداد: .2

 خذ البعد منه.أالذي تم 

 فوق خط البعد.أو  وهو القيمة الفعلية للبعد وتكون عادة داخل خط الامتداد: .3

 هو جزء من خط البعد يمتد بعد خط الامتداد. ملحق خط البعد: .4

 هو جزء من خطوط الامتداد تمتد بعد خط البعد. ملحق خط الامتداد: .5

 هي المسافة بين خط الامتداد والكائن الذي تم أخذ بعده. احة خط الامتداد عن الرسم:إز .6

 
 .بعادالأ خطوط مكونات (33 -4) شكل

 :بعادعمل أنماط مختلفة للأ 

عنها تختلف  لا بعادكما هو الحال مع النصوص والأعمل أنماط مختلفة إلى  غالباً ما نحتاج

أو  ،الرسومات المعمارية تقوم بعمل نمط بعدي للحصول على أنواع معينة من الأسهم مثلًا ففي

تسهل عملك وتمكنك من  بعادوسطه. كما أن أنماط الأأو  لوضع نص البعد فوق خط البعد

 .الأكثر استعمالًا بعادتخزين واستنساخ إعدادات الأ

 :ابهة لإنشاء نمط نصيوالمش ولإنشاء نمط بعدي جديد نتبع الخطوات التالية
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للتسع ثم ننقر على  Annotationننقر على المفردة   Home> Annotationمن قائمة  .1

 .(34 -4) كما في الشكل  Manage Dimension Styleالنص 

 
 . Dimension نمط ضافةإ( 34 -4) شكل

النصوص. نماط أدارة إوالشبيهة بقائمة  Manage Dimension Styleستفتح لك نافذة  .2

الاستفادة من الموجود لإجراء أو  Newمن خلال النقر على  ذلكونبدأ و اً اًسننشئ نمط

 اًجديد اًسنختار هنا نمط Modifyتعديلات في حال كانت التعديلات بسيطة فننقر على 

New. 

 
 . Dimension Style Manager نافذة( 35 -4) شكل
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كما في  Create New Dimension Styleستظهر لنا نافذة  Newبعد النقر على  .3

 .(36 -4)الشكل 

 
 . Create New Dimension Style نافذة( 36 -4) شكل

 New Style Name  خانة فينقوم بكتابة اسم النمط الجديد  .4

  الخانة منثم نحدد نوع النمط الذي نرغب البدء منه Start With  في حالة عدم

 .Stander  عمل أنماط سابقة نختار

  لخانة ثم نختار نوع خط البعد الذي نرغب باستخدامه للنمطUse for بعادالأ 

 .(لخإ...نصف قطر الدائرةأو  المائلةأو  الطولية

 .New Style Name  النافذةفتظهر  للاستمرارContinue  نختار .5

 من علامة التبويب Lines النافذة في New Dimension Style  نقوم بتحديد

 . وخطوط الامتداد بعادمواصفات خط الأ

حيث يمكننا تعديل خصائص ومواصفات خط البعد مثل اللون ونوع الخط وسمكه 

خط البعد من الجزء اتجاهين من أو  إخفاء اتجاهأو  وتحديد طول ملحق خط البعد وإظهار

 . Dimension Lines الخاص بخط البعد

وكذلك يمكننا تعديل خصائص ومواصفات خط الامتداد مثل اللون ونوع الخط وسمكه 

اتجاهين من خط الامتداد من الجزء أو  إخفاء اتجاهأو  وتحديد طول ملحق خط الامتداد وإظهار

 . Extension Linesالخاص بخط الامتداد
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 .New Dimension قائمة ضمن Lines قائمة خيارات عرض( 37 -4) شكل

  ثم نقوم بتحديد خيارات التحكم بالأسهم وملاحق خط البعد لنهاية خط البعد

 .Symbols and Arrowsعلامة القائمة  من

 
 .بعادالأ سهمأو رؤوس نواعأ (38 -4) شكل
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 التحكم في تغيير شكل نهاية خط البعد وحجمه من الجزء الخاص بشكلحيث يمكن 

والأقواس  إخفاء علامة المركز للدوائرأو  وكذلك يمكن تحديد إظهار Arrowheads السهم

 .Center Marksمن الجزء الخاص بذلك 

 
 . New Dimension Style النافذة في  Symbols and Arrows التبويب علامة خيارات يوضح (39 -4) شكل

 

 ثم نقوم بتحديد خيارات النص من علامة التبويب Text  حيث يمكن التحكم

وكذلك Text appearance  النص من الجزء الخاص بظهور النص بمظهر

يمكن التحكم بموقع ظهور النص واتجاهه على خط البعد من الجزء الخاص 

يمكن التحكم بمحاذاة النص  وكذلكText placement  بوضع وموقع النص

 .Text alignment  بالنسبة لخط البعد من الجزء الخاص بمحاذاة النص
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 . New Dimension Styleبـ الخاصة النافذة في Text التبويب علامة خيارات يوضح (40 -4) شكل

  ثم نقوم بتحديد خيارات وحدة القياس من علامة التبويبPrimary Units  حيث

 .يمكن اختيار وحدات القياس وضبط خيارات المنازل العشرية

 
 .New Dimension Style نافذة في  Primary Units الـ قائمة خيارات يوضح (41 -4) شكل
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 :بعادأدوات عمل الأ

عن طريق  أو   Home> Annotation من القائمة بعادأدوات عمل الأإلى  الوصـــــــــــــــــوليمكن 

 .Dli  الاختصار

 
 .بعادالأ دواتأ شريط (42 -4) شكل

 :خطوات

 وهي: رئيسةنواع أ 3 بعادخطوط الأنواع أن أقبل البدء بالعملي علينا تبيين 

 الخارجية بعادالأ

 الكلي .أ

 المحوري .ب

 التفصيلي .ج

 الداخلية  بعادلأا

 كلي .أ

 تفصيلي .ب

 

 .A-Dim بعادبالأعمل طبقة خاصة  .1

 .Home> Annotation> Linerالأمر  اختيار .2

  الأولى.سيطلب منك البرنامج تحديد النقطة  .3

Specify first extension line origin or <select 
object>: 

  .الأولى هي موقع النقطةسنرسم خط البعد الكلي في أعلى المبنى وستكون الزاوية 

 .نحدد النقطة الثانيةن أسيطلب منا  ذلكبعد  .4

Specify second extension line origin: 

 .الكلي البعد وهي نهائية نتيجة لتعطي المبنى نهاية ستكون والتي الثانية النقطة ستختار
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 .)النقطتين(سيطلب منك البرنامج تحديد المسافة بين خط البعد والمبنى لك ذبعد  .5

Specify dimension line location 
 

ن أعاد على بلترتيب خطوط الأ ذلك)للبعد الكلي( عن المبنى و 1,50وستكون المسافة 

 .عن بعضها بمسافة نصف متر بعادتبتعد خطوط الأ

 
 .بعادالأ وخط النقطتين بين المسافة تحديد منك سيطلب (43 -4) شكل

 

أمر  كنت قد حددت نقاط البعد باستخدامن إنحدد بالنقر أو   1.50ندخل القيمة  .6

offset. 

 .(43 -4)لتصبح النتيجة كما في الشكل  بعادالأنواع أتكرر العملية نفسها مع كل 
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 .التفصيلي للمبنى قربهاأو المحوري، الكلي، الثلاثة بعادالأ ضافةإ بعد (44 -4) شكل
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 تمارين الوحدة

م 1.20شرفة خارجية بطول الغرفة وبعرض ضف أم ثم 7قم بتكبير الغرفة لتصبح بطول  .1

 .(45 -4)الشكل 

م  1.80مع ممر بعرض  16وحدات متعددة متناظرة ليكون مجموع الغرف نشاء إبقم  .2

 .(45 -4)كما في الشكل 

  .على الرسومات بعادالأضف أ .3

ثم  (45 -4)( انظر الشكل 2.75×2.70( وغرفة مصعد )2.60×5قم بإنشاء غرفة درج ) .4

 .قم بعمل كتلة لهما ليسهل نسخهما

 

 
 .درج غرفة مع مصعد (45 -4) شكل
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 للمشروع النهائي الشكل (46 -4) شكل
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 نموذج تقييم المتدرب لمستوى أدائه

 ء من تمارين الوحدةالمتدرب نفسه وذلك بعد الانتهايعبأ من قبل 

، قيم  الأبعاد والنصوص وتظليل الرسومات ةوحدة إضافبعد الانتهاء من التدرب على 

نفسك وقدراتك بواســـطة إكمال هذا التقييم الذاتي بعد كل عنصر من العناصر المذكورة، 

قنته، وفي حالة عدم قابلية المهمة للتطبيق ( أمام مستوى الأداء الذي أتوذلك بوضع عـــــلامة )

 ضع العلامة في الخانة الخاصة بذلك. 

 العناصـــــر م

 مستوى الأداء

 )هل أتقنت الأداء( 

غير قابل 

 للتطبيق
 كليا جزئيا لا

     .على الرسومات المعمارية بعادعمل الأ  1

     .بشكل صحيح بعادتنسيق خطوط الأ  2

     .بعادللأ مختلفةنماط أإنشاء   3

     .استخدام النصوص في الرسومات  4

     .مختلفة للنصوصنماط أنشاء إ  5

     . Hatch التشهير أوامراستخدام   6

أو  درجة الإتقان الكليإلى  يجب أن تصل النتيجة لجميع المفردات )البنود( المذكورة

"جزئيا" فيجب إعادة التدرب أو  أنها غير قابلة للتطبيق، وفي حالة وجود مفردة في القائمة "لا"

 على هذا النشاط مرة أخرى بمساعدة المدرب.
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 نموذج تقييم المدرب لمستوى أداء المتدرب

 تمارين الوحدةالانتهاء من يعبأ من قبل المدرب وذلك بعد 

 ...............................................اسم المتدرب : 
 

 ..............................التاريخ: 

 ..............................................رقم المتدرب  :
 المحاولة :

 العلامة: 

1 2 3 4 

... ... ... ... 

 نقاط 10مفردة يقيم بـ أو  كل بند

 النقاط. من مجموع %100الحد الأعلى: ما يعادل      من مجموع النقاط. %80الحد الأدنى: ما يعادل 

 بنود التقييم م
 النقاط )حسب رقم المحاولات(

1 2 3 4 

     .على الرسومات المعمارية بعادعمل الأ  1

     .بشكل صحيح بعادتنسيق خطوط الأ  2

     .بعادنماط مختلفة للأأإنشاء   3

     .استخدام النصوص في الرسومات  4

     .نماط مختلفة للنصوصأنشاء إ  5

     . Hatch التشهير أوامراستخدام   6

     المجموع

 ملحوظات:   

............................................................................................................ 

............................................................................................................ 

 توقيع المدرب: .............................
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 تمارين

 مشروع فيلا سكنية
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 تمارين

 مشروع فيلا سكنية

 وصف المشروع :

الدور  سكنية من دورين( ... يشتمل )فيلاالرسومات المرفقة تمثل مشروعاً ابتدائياً لمبنى 

مجلس  ،نساء لمدخ ،معيشةصالة  ام +طعقاعة  ،مجلس رجال ،رْضي بها على مدخل رجالالأ

 دورةو ،مغاسلو اً،حمامو اً،مخزنو اً،مدخل خدمة ومنطقة خدمات تضم مطبخإلى  نساء إضافة

حمام خاص بها  ملحق رئيسة نوم وغرفة معيشة صالة على بالفيلا الأول الدور ويشتمل . مياه

 منطقة خدمات تضم أوفيس وتراسات.إلى  إضافة ،وغرفتي نوم أطفال مع حمام

 

 الملحوظات المعمارية :

 م(. 0.15م ( وبارتفاع )  1يُحيط بمبنى الفيلا السكنية رصيف بعرض )   .1

 م (.0.90منسوب تشطيب أرضية الدور الأرضي ) +  .2

النساء  . مدخل،الجهة الغربية فيالمدخل الرئيس للفيلا السكنية ) مدخل الرجال ( يقع  .3

 الجهة الشمالية من المبنى. فيمدخل الخدمة يقع  ،الجهة الجنوبية فييقع 

منسوب  منم( مقاس  2.90)لكلٍ من الدور الأرضي والدور الأول  فيالارتفاع الصا .4

 تشطيب الأرضية وحتى باطن السقف الخرساني.

 سم (. 20سمك جميع الجدران من المبنى )  .5

 سمك بلاطة السقف الخرساني لكل من سقف الدور الأرضي وسقف الدور الأول .6

 سم(.15)

 سم(. 50)يعلو الشبابيك من الدور الأرضي والدور الأول مظلات ببروز  .7

داخلي ال الدرج الخارجي والدرجمن  سم( 15)وارتفاع القائمة  سم( 30)القائمة عرض  .8

 للمبنى.

السقف  مقاسة من منسوب أعلى بلاطة م( 1.10)بارتفاع  )ستارة(يعلو المبنى دروة  .9

 الخرساني.

بلاطة السقف  مقاس من منسوب أعلى م( 2.95)لبيت الدرج أعلى المبنى  فيالصاالارتفاع  .10

 م (. 0.30( بارتفاع ))ستارةالخرساني للدور الأول ويعلو بيت الدرج دروة 
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 الرسومات المطلوب إعدادها لمشروع الفيلا السكنية

 .للدور الأرضيفقي الأالمسقط  .1

 .المتكررالمسقط الأفقي للدور  .2

 س / س. )العرضي(القطاع الرأسي المار بالدرج  .3

 .صالقطاع الرأسي الطولي ص /  .4

 .الشمالية( الجانبية الواجهة ،الرئيسة الغربية )الواجهةالواجهات  .5

 .للمشروعالموقع العام  .6

 المسقط الأفقي لأعمال التمديدات الصحية للدور الأرضي. .7

 الأول.المسقط الأفقي لأعمال التمديدات الصحية للدور  .8

 (.الفتحاتعمل الجداول الخاصة بالمشروع )جدول نماذج  .9
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 جدول الأبواب 

 بيان المواصفات

 بعادالأ

ج
اذ

نم
ال

 ضعر الارتفاع 

 1.00و  0.80باب خشب حشو بانوهات مفصلي بورقتين )

  (م
 1ب 1.8 2.20

 2ب 2.00 2.20 ملم ( مفصلي بورقتين 6)وزجاج سمك  ألمنيومباب 

ــلي بورقتين )   ــو بانوهات مفصــــ ــب حشــــ و   0.60باب خشــــ

  (م 0.90
 3ب 1.50 2.20

 4ب 1.60 2.20 باب خشب منطبق

 5ب 0.90 2.20 باب خشب حشو بانوهات مفصلي درقة واحدة

ملم( مفصلي درفة  6باب خشب تجليد أبلكاش سمك )

 واحدة
 6ب 0.80 2.20

 7ب 1.50 2.20 ملم ( مفصلي بورقتين 6باب ألمنيوم وزجاج سمك ) 

 ق 1.20 2.20 فتحة عتب
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 جدول الشبابيك

 بيان المواصفات
ارتفاع 

 الجلسة

 بعادالأ

ج
اذ

نم
ال

 عرض الارتفاع 

ملم ( منزلق  6)شباك ألمنيوم وزجاج سمك 

 أربع درف
 1ش 2.40 1.20 1.00

منزلق  ملم(4وزجاج سمك ) ألمنيومشباك 

 بورقتين
 2ش 1.40 1.20 1.00

منزلق  ملم( 4)شباك ألمنيوم وزجاج سمك 

 بورقتين
 3ش 0.80 1.20 1.00

قلاب  ملم( 4)شباك ألمنيوم وزجاج سمك 

 بورقتين
 4ش 0.80 1.20 1.00

ملم مفصلي  6)شباك ألمنيوم وزجاج سمك 

 واحدة(درفة 
 5ش 0.70 0.80 1.00

ملم ( مفصلي  6)شباك ألمنيوم وزجاج سمك 

 درفة واحدة
 6ش 0.70 1.00 1.00
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2.60
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 نموذج تقييم المتدرب لمستوى أدائه

 المتدرب نفسه وذلك بعد الانتهاء من تمارين الوحدةيعبأ من قبل 

، قيم نفسك وقدراتك بواســـطة إكمال هذا تمارينالبعد الانتهاء من التدرب على 

( أمام التقييم الذاتي بعد كل عنصر من العناصر المذكورة، وذلك بوضع عـــــلامة )

مستوى الأداء الذي أتقنته، وفي حالة عدم قابلية المهمة للتطبيق ضع العلامة في الخانة الخاصة 

 بذلك. 

 العناصـــــر م

 مستوى الأداء 

 )هل أتقنت الأداء(

غير قابل 

 للتطبيق
 كليا جزئيا لا

     .رضيالأرسم المسقط الدور   1

     .رسم المسقط الدور المتكرر  2

     .سيأالررسم القطاعات   3

     .رسم الواجهات  4

     .رسم الموقع العام  5

أو  درجة الإتقان الكليإلى  يجب أن تصل النتيجة لجميع المفردات )البنود( المذكورة

"جزئيا" فيجب إعادة التدرب أو  أنها غير قابلة للتطبيق، وفي حالة وجود مفردة في القائمة "لا"

 أخرى بمساعدة المدرب.على هذا النشاط مرة 
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 نموذج تقييم المدرب لمستوى أداء المتدرب

 تمارين الوحدةالانتهاء من يعبأ من قبل المدرب وذلك بعد 

 ...............................................اسم المتدرب : 
 

 ..............................التاريخ: 

 ..............................................رقم المتدرب  :
 المحاولة :

 العلامة: 

1 2 3 4 

... ... ... ... 

 نقاط 10مفردة يقيم بـ أو  كل بند

 من مجموع النقاط. %100الحد الأعلى: ما يعادل      من مجموع النقاط. %80الحد الأدنى: ما يعادل 

 بنود التقييم م
 المحاولات(النقاط )حسب رقم 

1 2 3 4 

     .رضيالأرسم المسقط الدور   1

     .رسم المسقط الدور المتكرر  2

     .سيأالررسم القطاعات   3

     .رسم الواجهات  4

     .رسم الموقع العام  5

     المجموع

 ملحوظات:   

............................................................................................................ 

............................................................................................................ 

 .....توقيع المدرب: ........................
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 المراجــع

 المرجع م

 دارة العامة للمناهجالإ، الرسم التنفيذي بالحاسب 1

2 AUTOCAD 2017 and AUTOCAD LT 2017 Essential,  Scott Onstott 

3 Learn about AutoCAD, Autodesk 

4 Mastering AutoCAD 2016, George Omura & Brian C. Benton 

5 Engineering Graphics 4th Edition, Frederick E. Giesecke 
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 ملحقات
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 Officewiseالمصدر – المكتبية للأعمال: الجلوس والتمارين الصحيحة الملحقات )أ(

تتردد  عند الشعور بالتعب لا

بالوقوف والقيام ببعض التمارين 

الجسم  أطرافطة لجميع يالبس

 مما ينشط الدورة الدموية.

 كتافالأ

 

 

 

 الرقبة

 

 الذراع والمعصم

 

 
 القدمين

 

 العينين

 

 الجلسة الصحيحة
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 وتوكادالأطريقة تثبيت برنامج  لملحقات )ب(ا

 مقدمة

كل الطلاب الجامعيين ليسمح لهم بالتعلم على جميع ل اًمجاني اًحساب Autodeskتوفر شركة 

بشكل مجاني لمدة  AutoCADتيحها الشركة. ومن ضمن تلك البرامج برنامج المنتجات التي ت

 ذلكو 5GBبمساحة  Autodesk Cloudتوفر لك مساحة حفظ سحابية  ذلكك. أربع سنوات

 .AutoCADعند تسجيل الدخول داخل برنامج 

 وربما ستتغير بالسنوات المقبلة. 2020سنشرحه هي طريقة التسجيل بعام  ما

 Autodesk 360إنشاء حساب على 

 في البداية عليك الدخول على الموقع الخاص بالبرنامج  .1

https://www.autodesk.com/education/home 

 

مرة أخرى لتتمكن من الدخول  Sign Inثم اختر الصفحة على أفي  Sign inانقر على  .2

 .التسجيل لصفحة

https://www.autodesk.com/education/home
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 . Create Accountستفتح صفحة تسجيل الدخول واختر  .3

 
 الآتي: ستظهر لك هذه النافذة والتي تطلب منك  .4
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 First Name الاسم الأول

 Last Name الاسم الأخير )العائلة(

 Email الإلكترونيالبريد 

 Confirm Email الإلكترونيتأكيد البريد 

 Password الرقم السري

 . I agreeثم انقر على الموافقة على الشروط 

 . Create Accountبياناتك الشخصية قم بالنقر على إدخال بعد  .5

بإرسال الشركة ستقوم بأن هذه النافذة مفادها  الحساب،إنشاء عملية أنهيت وهكذا قد  .6

 .الإلكترونيعلى بريدك فعاليات تقوم بها الشركة أو  إعلانات تجارية تسويقية
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شكل   أن وسنلاحظ  الرئيسة  الصفحة  سيقوم الموقع بتحويلك على   DONEبعد النقر على  .7

 الشـــــــــــــــــــــــــــريط بــــأعلى الصـــــــــــــــــــــــــــفحــــة قــــد تغير وهو بوضـــــــــــــــــــــــــــع الــــدخول. 

 
 Verify yourالخاص بك لتفعيل الحساب الإلكتروني البريد إلى  رسالةإرسال سيتم  .8

Autodesk account . 

 

 . Free Softwareشريط الخدمات  ر منانخت .9

 
 .وسيتم تحويلنا على قائمة البرامج  .10
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 . AutoCADنقوم باختيار البرنامج  .11

نكمل بياناتنا أن سنحتاج  ذلكولكن قبل وستفتح معنا نافذة التنزيل الخاصة بالبرنامج  .12

 . Complete Profileالشخصية 

 
 .وتاريخ الميلاد، المستوى الجامعي ،الدولةالبيانات إدخال نقوم ب .13
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تاريخ و ،والغرض من استخدامك البرامج ، TVTCالمؤسسة إدخال ب نقوم ذلكثم بعد  .14

  للتخرج.دخولك الكلية/المعهد والوقت المتوقع 
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وستتيح لنا  نقوم بالدخول على صفحة البرنامج مرة أخرى واتباع الخطوات ذلكبعد  .15

 .وتفعيل البرامجتسجيل الدخول 

 :الإصدار ونظام التشغيلنقوم باختيار 

 

 Version البرنامجصدار إ

حسب الإصدار الذي  Windowsنظام التشغيل 

 تعمل عليه

Operating system 

 English Languageاللغة الإنجليزية 
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تقوم بنسخه والاحتفاظ  للبرنامج اًتسلسلي اًرقمبإعطائنا البيانات سيقوم الموقع إدخال بعد  .16

  .ثبيت البرنامجبه لحين بدء ت

 الإلكتروني.د ستحصل على نسخة من هذا الرقم عبر البري ملاحظة

 

تثبيت البرنامج بشكل   Installأو  لتحميل البرنامج Downloadسيتفعل لك زر ثم ومن  .17

 .مباشر


